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Bab 1

Pengertian Komputer: Fungsi,
Jenis, dan Komponen
Komputer

1.1 Pengertian Komputer

Apa yang dimaksud dengan komputer? Secara umum, pengertian Komputer
adalah suatu perangkat elektronik yang dapat digunakan untuk mengolah data
sesuai dengan prosedur yang telah dirumuskan sebelumnya sehingga
menghasilkan informasi bermanfaat bagi penggunanya (Prawiro, 2019).
Komputer adalah alat yang dipakai untuk mengolah data menurut prosedur
yang telah dirumuskan. Kata computer semula dipergunakan untuk
menggambarkan orang yang perkerjaannya melakukan perhitungan aritmatika,
dengan atau tanpa alat bantu, tetapi arti kata ini kemudian dipindahkan kepada
mesin itu sendiri. Asal mulanya, pengolahan informasi hampir eksklusif
berhubungan dengan masalah aritmatika, tetapi komputer modern dipakai
untuk banyak tugas yang tidak berhubungan dengan matematika.

Dalam definisi seperti itu terdapat alat seperti slide rule, jenis kalkulator
mekanik mulai dari abakus dan seterusnya, sampai semua komputer elektronik
yang kontemporer. Istilah lebih baik yang cocok untuk arti luas seperti
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“komputer” adalah “yang memproses informasi” atau ‘“sistem pengolah
informasi. (pendidikan, 2020)

Gambar 1.1: Komputer. Sumber (Prawiro, 2019)

Definisi komputer adalah alat elektronik yang terdiri dari rangkaian berbagai
komponen yang saling terhubung sehingga membentuk suatu sistem kerja.
Sistem di dalam komputer tersebut dapat melakukan pekerjaan secara otomatis
berdasarkan program yang diperintahkan kepadanya sehingga mampu
menghasilkan informasi berdasarkan data dan program yang ada.

Pada umumnya komputer terdiri dari 3 elemen utama, antara lain:

1. Perangkat Keras (Hardware) yang terdiri dari Processor, RAM,
Harddisk, Motherboard, dan CPU.

2. Perangkat Lunak (Software) yaitu sistem operasi dan juga berbagai
aplikasi yang dimasukkan ke dalam hardware dan bekerja sesuai
perintah dari pengguna.

3. Pengguna Komputer (Brainware) yaitu pemakai atau operator
komputer.

Secara etimologis, kata “Komputer” berasal dari bahasa Latin, yaitu
“Computare” yang artinya menghitung. Sehingga secara sederhana pengertian
komputer adalah alat untuk menghitung aritmatika.



Bab 1 Pengertian Komputer: Fungsi, Jenis, dan Komponen Komputer 3

1.2 Pengertian Komputer Menurut Para
Anhli

Agar lebih memahami apa arti komputer, maka kita dapat merujuk pada

pendapat para ahli berikut ini:

1. Robert H. Blissmer
Menurut Robert H. Blissmer, pengertian komputer adalah suatu alat
elektronik yang mampu melakukan beberapa tugas, yaitu menerima
input, memproses input sesuai dengan instruksi yang diberikan,
menyimpan perintah-perintah dan hasil pengolahannya, serta
menyediakan output dalam bentuk informasi.

2. V.C.Hamacher
Menurut V. C. Hamacher, definisi komputer adalah mesin
penghitung elektronik yang cepat dan dapat menerima informasi
input digital, kemudian memprosesnya sesuai dengan program yang
tersimpan di memorinya, dan menghasilkan output berupa informasi.

3. Donald H. Sanders
Menurut Sanders, pengertian komputer adalah sistem elektronik yang
digunakan untuk memanipulasi data yang cepat serta tepat, dirancang
dan diorganisasikan agar dapat secara otomatis menerima dan
menyimpan data, memproses data hingga menghasilkan output
berdasarkan perintah yang sudah tersimpan di dalam memori.

4. Wiliam M. Fuori
Menurut Fuori, pengertian komputer adalah suatu alat pemroses data
yang bisa melakukan perhitungan secara besar dan cepat, termasuk
perhitungan aritmatika serta operasi logika, dan tidak ada campur
tangan manusia.

5. Robert H. Blissmer
Menurut Robert H. Blissmer, pengertian komputer adalah suatu alat
elektronik yang mampu melakukan beberapa tugas diantaranya
menerima input, memproses input, menyimpan perintah-perintah dan
menghasilkan output yang berbentuk informasi.
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Williams & Sawyer

Menurut Williams & Sawyer, definisi komputer adalah mesin
serbaguna yang dapat diprogram, bisa menerima data (fakta-fakta
serta gambar-gambar kasar) dan memproses atau memanipulasi data
tersebut ke dalam informasi yang dapat digunakan.

1.3 Fungsi Komputer

Pada dasarnya fungsi komputer sangat beragam, tergantung pada para
penggunanya. Mengacu pada pengertian komputer di atas, berikut adalah
fungsi utamanya:

1.

Gambar 1.2: Fungsi Komputer. Sumber (Prawiro, 2019)

Data Input

Komputer dapat menerima informasi atau data dari sumber lain. Data
tersebut diterima melalui aktivitas di keyboard, mouse, dari komputer
lain atau peralatan lainnya.

Data Processing

Salah satu fungsi utama komputer adalah untuk melakukan
pengolahan data sehingga menghasilkan output, yaitu berupa
informasi. Umumnya, data yang diolah di dalam komputer adalah
berbentuk teks, gambar, audio, video, grafik, dan lainnya.
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3. Data Output
Fungsi komputer berikutnya adalah untuk menghasilkan output/
informasi setelah melalui proses pengolahan data. Informasi tersebut
dapat disajikan melalui monitor, alat printer, dan speaker.

4. Data Storage
Komputer juga dapat berfungsi sebagai tempat untuk menyimpan
data sehingga dapat ditemukan dengan mudah dan digunakan
kembali. Data tersebut dapat disimpan di dalam memori internal
komputer maupun memori eksternal.

5. Data Movement
Fungsi lain dari komputer adalah untuk memindahkan data dari satu
komputer ke komputer lainnya atau berbagai alat output lainnya.

1.4 Komponen Sistem Komputer

Layaknya internet, komputer adalah benda wajib yang harus dimiliki di era
digital seperti sekarang. Banyak hal yang bisa di lakukan dengan bantuan
komputer seperti mengerjakan tugas sekolah, menyelesaikan pekerjaan kantor
atau hanya sekedar untuk berselancar di dunia maya. Sistem komputer terdiri
dari tiga komponen penting yaitu hardware, software dan brainware.
Pemaparan sebagai berikut ini. (Kominfo, 2019)

Gambar 1.3: Komponen Sistem Komputer
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Hardware/ Perangkat Keras

Hardware merupakan perangkat keras yang kasat mata dan memiliki
wujud fisik yang dapat diraba. Hardware pada komputer sendiri

masih dibagi lagi menjadi empat bagian yaitu input device, output

device, processing device dan storage device.
Berikut ulasannya:

Input Device/ Perangkat Masukan

Bagian pertama adalah input device atau perangkat masukan.
Yang termasuk dalam input device ini adalah keyboard, mouse,
webcam dan juga scanner. Perangkat tersebut dikategorikan input
device karena fungsinya sebagai alat untuk memasukan berbagai
data dan juga perintah pada komputer. Sebuah data atau instruksi
harus di input terlebih dahulu sebelum diolah menjadi informasi
yang seperti kita inginkan, oleh karena itu dibutuhkan sebuah
unit input yang menjadi sebuah gerbang untuk data yang dari
dunia luar masuk ke dalam sistem komputer. Bentuk-bentuk data
yang telah diinput akan dikonversi menjadi kode binary sehingga
dapat dibaca oleh memori utama.

Processing Device/ Perangkat Proses

Data yang dimasukan melalui input device selanjutnya akan
diolah melalui processing device. Dengan kata lain, processing
device adalah perangkat yang berfungsi untuk mengolah berbagai
data yang berasal dari input device. Yang termasuk dalam
processing device adalah CPU (Central Processing Unit). Peran
CPU sangat penting didalam sebuah komputer karena merupakan
otak dari sistem komputer. CPU sekaligus juga perangkat yang
mengatur semua perangkat internal dan eksternal di komputer.
Output Device/ Perangkat Keluaran

Perangkat keluaran atau output device adalah perangkat yang
memberikan atau mengeluarkan hasil dari data yang masuk dan
telah diproses. Contoh dari output device ini adalah monitor,
printer, headphone, speaker, webcam dan mikrofon. Dengan kata
lain output device ini menyajikan segala informasi yang didapat
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dari pemrosesan sistem komputer seperti gambar, suara dan
video.
e Storage Device/ Perangkat Penyimpanan
Perangkat terakhir pada hardware adalah  perangkat
penyimpanan. Sesuai dengan namanya, perangkat ini adalah alat
yang digunakan untuk menyimpan berbagai data. Storage device
sendiri terdiri dari dua macam yaitu internal storage dan eksternal
storage. Contoh dari internal storage adalah harddisk dan RAM.
Sedangkan external storage misalnya adalah harddisk eksternal,
CD, DVD dan flashdisk.
2. Software/ Perangkat Lunak
Komponen sistem komputer selanjutnya adalah software.
Berkebalikan dari hardware, software adalah komponen yang tak
kasat mata. Software dalam komputer adalah komponen penting
karena berperan menjalankan segala perintah yang masuk ke
hardware. Software dapat diartikan juga sebagai suatu kumpulan data
elektronik yang tersimpan dan diatur oleh komputer, bisa berupa
program ataupun koneksi untuk menjalankan berbagai macam
instruksi perintah. Software dibagi menjadi tiga yaitu software
sistem, software aplikasi dan software tambahan. Software sistem
merupakan software utama yang sangat penting karena bertugas
mengatur komponen pada komputer secara menyeluruh. Contoh
software diantaranya adalah Windows Xp, Windows 2000, Windows
7, Linux, IOS dan lain-lain. Software aplikasi adalah kategori untuk
software yang digunakan oleh user untuk menyelesaikan sebuah
tugas tertentu. Dalam hal ini bisa dikatakan bahwa software aplikasi
merupakan software pelengkap pada komputer yang digunakan
sebagai sarana pengolahan data. Contohnya adalah web browser,
software office, game dan lainnya. Sedangkan software tambahan
adalah software yang menjalankan tugas-tugas khusus atau tambahan
sekaligus melindungi hardware. Contohnya seperti Data recovery,
Disk Defragmenter, Sceensever, Backup, dan lain-lain.
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3.

Brainware

Komponen terakhir yang menutup serangkaian komponen sistem
komputer adalah brainware. Brainware yaitu orang yang menjalankan
atau mengoperasikan komputer. Brainware sangat penting karena
komputer tidak dapat bermanfaat jika tidak dioperasikan oleh
manusia. Jadi brainware merupakan setiap orang yang terlibat dalam
kegiatan-kegiatan pemanfaatan komputer. Contoh dari brainware
diantaranya adalah programmer, sistem analis, operator dan
administrator.

1.5 Jenis-Jenis Komputer

Berdasarkan bentuk dan ukurannya, komputer dapat dibedakan menjadi tujuh
jenis komputer.

Adapaun jenis-jenis komputer adalah sebagai berikut:

1.

Komputer Portabel

Ini adalah jenis komputer yang mudah dibawa kemana saja, di mana
penggunaannya untuk keperluan penelitian di lapanan dan berpindah-
pindah. Jenis komputer ini kurang populer karena cenderung berat
dan lebih besar dari laptop pada umumnya.

Komputer Desktop

Sesuai dengan namanya, ini adalah komputer yang ada di atas meja.
Komputer ini memiliki CPU yang terpisah dari monitor dan
keyboard.

Komputer Palmtop

Ini adalah komputer yang bentuknya kecil dan bisa digenggam.
Komputer jenis ini sudah sangat jarang digunakan sejak
ditemukannya Smartphone.

Komputer Tower

Ini adalah komputer yang bentuknya lebih besar dari komputer
desktop dan biasanya diletakkan di atas atau samping meja.
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Komputer ini dapat ditambahkan perangkat pendukung karena
memiliki expansionslot.

Komputer Notebook

Ini adalah jenis laptop namun dengan ukuran yang lebih tipis.
Umumnya banyak digunakan oleh pelajar, pengajar, dan peneliti
yang membutuhkan perangkat komputer yang ringkas dan ringan.
Handbook (Sub-notebook)

Ini adalah jenis notebook yang ukurannya lebih kecil dari notebook
pada umumnya. Umumnya handbook memiliki processor dengan
spesifikasi yang rendah.

Komputer Laptop

Ini adalah jenis komputer yang dapat diletakkan di pangkuan
penggunanya. Laptop memiliki CPU, monitor, dan keyboard yang
menyatu dan mudah dibawa kemana-mana.

1.6 Tipe Komputer lainnya

Saat ini, banyak alat elektronik berbasis komputer dengan fungsi-fungsi yang
spesifik, tetapi kita tidak selalu memahami cara kerja mereka demikian.

Berikut ini merupakan beberapa contohnya.

1.

Ponsel cerdas: Banyak ponsel cerdas dapat melakukan banyak hal
yang dapat dilakukan oleh komputer, seperti menjelajah internet dan
bermain game. Biasanya ponsel cerdas ini sering disebut dengan
smartphone.

Wearables: Teknologi Wearable adalah istilah umum untuk
sekelompok alat, termasuk pelacak/pencatat kebugaran/olahraga dan
jam tangan cerdas, yang dirancang untuk dipakai sehari-hari.
Perangkat tipe ini sering disingkat dengan istilah wearables.

Alat permainan (game): Sebuah alat/konsol permainan adalah
komputer tipe khusus yang dapat digunakan untuk bermain video
game di TV.
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4. Televisi (TV): Saat ini, banyak televisi dilengkapi dengan aplikasi
(atau apps), yang dapat digunakan untuk mengakses berbagai macam
konten online. Sebagai contoh, Menonton streaming video langsung
dari internet ke televisi.



Bab 2

Perkembangan Komputer

2.1 Sejarah Perkembangan Komputer

Dengan kemajuan perkembangan teknologi komputer pada masa sekarang,
membuat teknologi informasi sangat maju pesat, adapun Seiring
perkembangan jaman, komputer mengalami evolusi begitu pesat, dalam usaha
penerapan komputer serta perkembangan teknologi, informasi dan
telekomunikasi.

2.2 Definisi Komputer Menurut Para Ahli

Beikut ini merupakan definisi komputer dari para ahli:

1. Robert H Blissmer, menyatakan bahwa Komputer adalah suatu alat
elektronik yang mampu melakukan beberapa tugas antara lain
menerima input,memproses input tadi sesuai dengan programnya,
menyimpan perintah-perintah dan hasil dari pengolahan dan
menyediakan output dalam bentuk informasi.

2. Fouri, berpendapat bahwa computer adalah suatu alatpemroses data
yang mampu melakukan perhitungan dengan jumlah besar dengan
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10.

cepattermasuk operasi logika dan aritmatika, tanpa manusia ikut
campur.

Jhon J. Longkutoy berpendapat bahwa komputer adalah pemecah
persoalan atau pengolah data yang dapat menghasilkan informasi
yang diperlukan.

Donald H.Sanders, Komputer adalah sistem elektronik untuk
memanipulasi data yang cepat dan tepat serta dirancang dan
diorganisasikan supaya secara otomatis menerima dan menyimpan
data input, memprosesnya dan menghasilkan output dibawah
pengawasan suatu langkah-langkah instruksi-instruksi program yang
tersimpan di memori.

C. Hamacher, Z.G. Vranesic. S.G. Zaky, Komputer adalah mesin
penghitung elektronik yang cepat dapat menerima informasi input
digital, memprosesnya sesuai dengan suatu program yang tersimpan
di memorinya dan menghasilkan output informasi.

Gordon B. Davis, Komputer adalah tipe khusus alat penghitung yang
mempunyai sifat tertentu yang pasti.

Elias M Awad, menyatakan bahwa komputer adalah alat hitung yang
memproses data yang disajikan dalam bentuk data diskret (digital)
dan data kontinyu (analog).

Larry Long & Nancy Long, komputer adalah alat hitung elektronik
yang mampu menginterpretasikan dan melaksanakan perintah-
perintah terprogram untuk input, output, perhitungan, dan operasi-
operasi logik.

June Parsons, berpendapat bahwa komputer adalah perangkat serba
guna yg menerima input, proses data, penyimpanan data, dan
menghasilkan output, semua menurut serangkaian instruksi di
simpan.

Garry b. Shelly & Randolph E. Gunter, menyatakan bahwa komputer
merupakan perangkat elektronik, beroperasi di bawah kendali
instruksi di simpan dalam memori, yang dapat menerima data,
mengelolah data sesuai dengan aturan yang ditetapkan, memproduksi
hasil.

12
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11. William M .Fouri, Komputer adalah suatu pemroses data (data
processor) yang dapat melakukan perhitungan besar dan cepat,
termasuk perhitungan aritmatika yang besar atau operasi logika,
tanpa campur tangan dari manusia mengoperasikan selama
pemrosesan.

2.3 Bagaian Komputer Bekerja

Saat teknologi yang dipakai pada komuter digital sudah berganti secara
dramatis sejak komuter pertama pada tahun 1940-an, kebanyakan komputer
masih memakai arsitektur Von Neumann, yang diusulkan pada awal 1940-an
oleh Jhon von Neumann dan ia menggambarkan komputer dengan empat
bagian utama, yaitu:

2.3.1 Memori

Pada sistem, memori merupakan merupakan urutan byte yang ada di menomri
(seperti “sel” atau “lubang burung dara”), masing-masing memiliki sepotong
kecil informasi. Informasi ini mungkin menjadi perintah untuk mengatakan
pada komputer apa yang harus dilakukan. Sel mungkin berisi data yang
dibutuhkan komputer untuk melakukan suatu perintah. Setiap slot mungkin
berisikan salan satu, serta apa yang sekarang menjadi data mungkin saja
kemudian menjadi perintah. Memori menyimpan bermacam bentuk informasi
sebagai angka biner. Informasi yang belum berbentuk biner akan dipecahkan
(encoded) dengan sejumlah intruksi yang mengubahnya menjadi sebuah angka
atau urutan angka-angka. Sebagai contoh: Huruf F disimpan sebagai angka
desimal 70 (atau angka biner) memakai salah satu metode pemecah. Intruksi
yang lebih kompleks dapat dipakai untuk menyimpan gambar, video, suara,
serta bermacam informasi. Informasi yang dapat disimpan dalam satu sell
dinamakan sebuah byte.

Secara umum, memori bisa ditulis kembali lebih dari jutaan kali _ memori bisa
diibaratkan sebagai papan tulis serta kapur yang bisa ditulis serta dihapus
kembali, daripada buku tulis dengan pena yang tidak bisa dihapus. kuran
masing-masing sel, serta jumlah sel, berubah secara hebat dari komputer ke
komputer, serta teknlogi dalam perbuatan memori sudah berubah secara behat
— dari relay elektromekanik, ke arah tabung yang diisi dengan air raksa (lalu
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kemudia pegas) di mana pulsa akustik terbentuk, sampai matriks magnet
permanen, ke setiap transistor, ke sirkuit perpadu dengan jutaan transistor
diatas satu chip silikon.

2.3.2 Pemprosesan

Unit pengolahan Pusat atau CPU (Central Processing Unit) berperan untuk
memproses perintah yang dibetikan oleh user komputer, pengelolanya bersama
data-data yang ada dikomputer. piranti pemrosesan juga akan berkomunikasi
dengan peranti imput, output serta strorage untuk melaksanakan instruksi yang
saling berkaitan. Dalam arsitetur von Neumann yang asli, ia mendefinisikan
sebuah Unit Aritmatika serta Logika , serta sebuah Unit Kontrol. Dalam
sebuah komputer kodern, kedua unit ini terletak dalam satu sirkuit terpadu (IC
— Integrated Circuit), yang biasanya disebut CPU (Cerntral Processing Unit).

Unit Aritmatika serta Logika, atau Arithmatic Logic Unit (ALU), merupakan
alat yang melakukan pelaksanaan dasar seperti pelaksanaan aritmatika
(pengurangan, tambahan, serta sejenisnya). pelaksanaan logis (AND, OR,
NOT), serta pelaksanaan perbandingan (contohnya, membandingkan isi
sebanyaknya dua slot untuk kesetaraan). Pada unit inilah dilakukan “kerja”
yang sebenarnya. Unit kontrol menyimpan perintah saat ini yang dilakukan
oleh komputer, memerintahkan ALU sebagai pelaksanaan serta mendapatkan
kembali informasi (dari memori) yang diperlukan untuk melaksanakan
perintah tesebut, serta memindahkan kembali hasil ke lokasi memori yang
sesuai. Unit ini memiliki fungsi mengontrol pembacaan intruksi perogram
komputer.

2.3.3 Masukan dan Hasil

/O membolehkan komputer mendapatkan informasi dari dunia luar, serta
menaruh hasil kerja disana, bisa berbentuk fisik (hardcopy) atau non fisik
(softcopy). Ada bermacam alat I/O, dari keyboard, monitor serta disk drive, ke
yang lebih tidak bisa seperti webcam (kamera web, pemindai, pencetak, serta
yang lainnya). Yang mempunyai semua alat masukan biasanya ialah bahwa
mereka meng-encode (mengubah) informasi dari suatu macam ke dalam data
yang dapat diolah lebih lanjut oleh sistem komputer digitral. Alat output, men-
decode data ke dalam informasi yang dapat dimengerti oleh pemakai
komputer. Dalam definisi ini, sistem komputer digital merupakan contoh
sistem pengolahan data.

14
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2.3.4 Instruksi

Perintah yang dibahas di atas bukan perintah seperti bahasa manusiawi.
Komputer hanya memiliki perintah sederhana dalam jumlah terbatas yang
dirumuskan dengan baik. Perintah biasa dipahami kebanyakan komputer
adalah “menalin isi sel 123, serta tempat tiruan di sel 456”, “menambahkan isi
sel 666 ke sel 042, serta tempat akibat di sel 013", serta : jika isi sel 999 ialah O,
perintah berikutnya anda di sel 345”.

Instruksi diwakili di dalam komputer sebagai nomor — kode untuk “menyalin”
mungkin menjadi 001, misalnya. Suatu himpunan perintah khusus yang
didukung oleh komputer tertentu diketahui sebagai bahasa mesin komputer.
Dalam peraktiknya, orang biasanya tidak menulis perintah untuk komputer
secara langsung dibahasa mesin namun memakai bahasa pemrograman
“tingkat tinggi” yang kemudia diterjamahkan ke dalam bahasa mesin secara
otomatis oleh program komputer khusus (interpreter serta kompilear).
Beberapa bahasa pemrograman berhubungan erat dengan bahasa mesin,
seperti assembler (bahasa tingkat rendah); di sisi lain, bahasa seperti Prolog
didasarkan pada prinsip abstrak yang jauh dari detail pelaksanaan sebenarnya
oleh mesin (bahasa tingkat tinggi).

2.4 Arsitektur

Komputer kontemporer menaruh Alu serta unit kontrol ke dalam satu sirkuit
perpadu yang dikenal sebagai Unit Pemprosesan Sentral atau CPU. Umumnya,
memori komputer ditempatkan diatas dengan beberapa sirkuit kecil dekat
UPS. Alat yang menempati sebagaian besar rungan dalam komputer
merupakan ancilliary sistem (contohnya, untuk menyediakan tanaga listrik)
atau alat I/O. Beberapa komputer yang lebih besar berbeda dari model diatas di
satu hal utama — mereka memiliki bebrapa UPS serta unit kontrol yang bekerja
secara bersamaan. Beberapa komputer, yang dipakai sebagian besar untuk
maksud penelitian serta perkomputeran ilmiah, sudah berbeda secara
signifikan dari model diatas, namun mereka sudah menemukan sedikit
penggunaan komersial. Fungsi dari komputer secara prinsip sebenarnya cukup
sederhana. KOmputer mencapai perintah serta data dari momorinya. Perintah
dilakukan, jasil disimpan, serta perintah berikutnya dicapai. Prosedur ini
berpeluang sampai komputer dimatikan.
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2.5 Program

Program komputer merupakan daftar besar perintah untuk dilakukan oleh
komputer, barangkali dengan dara di dalam tabel. banyak program komputer
berisikan jutaan perintah, serta banyak dari perintah tersebut dilakukan
berulang kali. Sebuah komputer pribadi modern yang umum (tahun 2003) bisa
melakukan sekitar 2-3 miliar perintah dalam sedikit. Komputer tidak mendapat
kemampuan luar biasa mereka lewat kemampuan untuk melakukan perintah
kompleks. Namun, mereka melakukanjutaan perintah sederhana yang diatur
oleh orang pandai, pemrograman “progremer Baik memperkembangkan set-
set peritah utnuk melakukan tugas biasa (contoh, menggambar titik di layar)
serta lalu membuat set-set perintah tersebut ada kepada programmer lain”. Saat
ini, kebanyakan komputer bisa melakukan beberapa program sekaligus. Ini
biasanya diserahkan sebagai multitasking.

2.6 Sistem operasi

Sistem operasi merupakan gabuangan dari potongan kode yang bermanfaat
(berguna). Saat kode komputer bisa dipakai secara bersama dengan beraneka
ragam program komputer, sesudah bertahun-tahun, pemrograman ahkhirnya
memindahkan dalam sistem operasi. Sistem operasi, menentukan prgraman
mana yang akan dijalankan, kapan, serta alat yang mana (seperti momori atau
I/O) yang mereka pakai. Sistem operasi juga memberikan sebuah layanan
(service) kepasa perogram lain, sama seperti kode yang memperbolehkan
pemrograman untuk menulis prgram untuk sebuah mesin tanpa harus
mengetahui dengan detail dari mana semua alat elektronik yang terhubung
pada komputer.

16



Bab 2 Perkembangan Komputer 17

2.7 Bagian-Bagian Komputer

Komputer terdiri atas 2 bagian besar yaitu perangkat lunak (software) dan
perangkat keras (hardware).

2.7.1 Perangkat Keras (Hardware)

1.

2.
3.
4

Pemroses atau CPU sebagai unit pengolah data

Memori RAM, tempat penyimpanan data sementara

Hard drive, media penyimpanan data semi permanen

Perangkat masukan, media yang digunakan untuk memasukkan data
untuk diproses oleh CPU, seperti mouse, keyboard, dan tablet
Perangkat keluaran, media yang digunakan untuk menampilkan hasil
keluaran pemrosesan CPU, seperti monitor, speaker, headset, plotter,
proyektor, dan printer

2.7.2 Perangkat Lunak (Software)

1.
2.

Sistem operasi

Program dasar pada komputer yang menghubungkan pengguna
dengan hardware komputer. Sistem operasi yang biasa digunakan
adalah Linux, Windows, dan Mac OS. Tugas sistem operasi termasuk
(namun tidak hanya) mengatur eksekusi program di atasnya,
koordinasi input, output, pemrosesan, memori, serta instalasi
software.

Program komputer

Merupakan aplikasi tambahan yang dipasang sesuai dengan sistem
operasinya

2.8 Slot pada komputer

1.
2.
3.

ISA/PCI, slot untuk masukan kartu tambahan non-grafis
AGP/PCle, slot untuk masukan kartu tambahan grafis
IDE/SCSI/SATA, slot untuk hard drive/ODD
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4. USB, slot untuk masukan media plug-and-play (colok dan mainkan,
artinya perangkat yang dapat dihubungkan ke komputer dan langsung
dapat digunakan)

2.9 Fungsi Hardware dan Software Komputer

Terlepas adanya perbedaan yang mencolok antara software dan hardware 2
jenis perangkat ini ternyata memiki fungsi masing-masing, Berikut
orangbejo.com telah merangkumnya.

2.9.1 Fungsi Hardware

1. Sebagai media pemberi masukan data (eksekutor).

2. Hardware berfungsi sebagai pengolah data.

3. Hardware juga mempunya fungsi sebagai penampil inputan dari
subuah proses.

2.9.2 Fungsi Software

1. Software berfungsi sebagai sistem operasi atau sistem pendukung.

2. Software berfungsi untuk mengatur (mengontrol) hardware.

3. Sofware juga berfungsi sebagai penerjemah setiap instruksi-instruksi
ke dalam bahasa mesin sehingga dapat di terima oleh hardware.

2.10 Sejarah Perkembangan Komputer dari
Generasi ke Generasi

Dengan mengikuti jaman perkembangan teknologi sekarang ini komputer
terus berevolusi dan berkembang dari generasi kegenerasi yang tebaru yang
awalnya mennggunakan tabung sekarang menggunakan chip.

18
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2.10.1 Generasi Pertama Menggunakan Tabung Vakum
(1946 — 1959)

Tahun 1946 merupakan tahun diciptakan komputer generasi pertama dengan
menggunakan tabung vakum sebagai komponen dasar pembuatan. Tabung
yang digunakan sebagai komponen dasar ini memang dikenal tidak efisien di
beberapa aspek karena cepat sekali panas ketika dipakai. Selain itu, komponen
ini membutuhkan daya listrik sangat besar dalam pengoperasiannya.
Electronic Numerical Integrator and Computer (ENIAC) merupakan salah
satu contoh komputer generasi yang pertama. Komputer generasi pertama
diciptakan oleh J.Presper Eckert dan John Mauchly di University of
Pennsylvania. Mereka berdua membangun ENIAC dengan menggunakan
18.000 tabung vakum dengan ukuran 1800 kaki dan mempunyai berat yang
mencapai sekitar 30 ton. Sejarah komputer generasi pertama ini menjadi digital
elektronik yang dipakai untuk kebutuhan paling umum. Program ENIAC ini
sudah di rancang pada tahun 1942 namun dimulai baru di tahun 1943 dan
selesai pada tahun 1946 .

Bentuk program ENIAC memiliki ukuran sangat besar bahkan pada
peletakkan program ini membutuhkan ruang seluas 500 m2. ENIAC juga
menggunakan 75.000 relay dan saklar, 18.000 tabung, 70.000 resistor, dan
10.000 kapasitor. Saat memulai pengoperasian, ENIAC membutuhkan daya
listrik sangat besar, yaitu sekitar 140 kW. Dana yang dibutuhkan untuk
membuat perangkat tersebut mencapai 1 juta dollar.
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Gambar 2.1: Komputer Generasi Pertama Menggunakan Tabung Vakum
(1946 —1959)
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Ciri-ciri komputer generasi pertama:

e Memiliki hardware yang jauh lebih besar serta membutuhkan ruang
yang luas.

e Interior design sistem operasi dibuat secara spesifik dan hanya dapat
melakukan tugas tertentu.

e Program hanya dapat dibuat memakai bahasa mesin.

e Menggunakan silinder magnetic untuk menyimpan data.

e Membutuhkan daya listrik sangat besar.

e Butuh mesin pendingin karena cepat panas.

e Kapasitas penyimpanan yang kecil.

¢ Kinerjanya lambat.

e Memakai konsep stored program dan menggunakan magnetic core
storage sebagai memori utama.

e Menggunakan tabung hampa sebagai sirkuit.

2.10.2 Sejarah Komputer Generasi Kedua Menggunakan
Transistor (1959 — 1965)

Tahun 1959, komponen dasar untuk merancang komputer adalah teknologi
transistor. Komponen ini dinilai jauh lebih efisien jika dibandingkan tabung
vakum. Transistor mempunyai ukuran lebih kecil dibandingkan tabung vakum
serta daya listrik yang diperlukan juga lebih kecil untuk pengoperasiannya.
Biaya pembuatan juga jauh lebih terjangkau. Bahasa pemrogaman telah
diganti menggunakan bahasa Assembly dan bahasa simbolik. Dengan
menggunakan bahasa pemrogaman tersebut, programmer dapat memberikan
instruksi dengan kata-kata.

Mesin yang pertama kali menggunakan teknologi ini ialah super komputer.
IBM juga telah membuat super komputer dengan nama Sprery-rand dan
Stretch serta menjadikan komputer dengan nama LARC. Komputer ini
dikembangkan di laboratorium menggunakan energi atom. Pada tahun 1965,
hampir berbagai bisnis besar menggunakan komputer generasi kedua untuk
memproses informasi dengan keuangan bisnis.
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Ciri-ciri komputer generasi kedua:

Telah menggunakan operasi bahasa pemrogaman tingkat tinggi
fortran dan cobol.

Kapasitas memori utama menggunakan magnetic core storage.
Menggunakan simpanan eksternal seperti magnetic tape dan
magnetic disk.

Mampu memproses secara real time dan real sharing.

Ukuran fisik jauh lebih kecil dibanding komputer di generasi
pertama.

Kinerjanya lebih cepat.

Daya listrik lebih kecil.

Pemakaian program ini tidak lagi terpaku pada aplikasi bisnis namun
juga pada aplikasi teknik.

Gambar 2.2: Komputer Generasi Kedua Menggunakan Transistor
(1959 — 1965)

2.10.3 Sejarah Komputer Generasi Ketiga Integrated
Circuit (1965 - 1971)

Generasi Komputer ketiga dimulai pada tahun 1965 yang mana komputer
dibuat menggunakan Integrated Circuit (ICs). Teknologi ini menggeser fungsi
transistor sebagai komponen dasar komputer. Transistor masih tetap digunakan
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tapi ukurannya diperkecil. Beberapa transistor yang berukuran kecil tersebut
dimasukkan di IC, bersamaan dengan resistor dan kapasitor. Komputer
generasi ketiga menjadi komputer pertama yang membuat operator dapat
berinteraksi menggunakan keyboard dan monitor dengan tampilan sistem
operasi. Selain itu, komputer ini membutuhkan biaya lebih murah sehingga
dapat dijangkau masyarakat umum.

Dalam penggunaannya, transistor membuat kinerja komputer cepat panas
sehingga komputer generasi kedua mulai ditinggalkan.

Ciri-ciri komputer generasi ketiga:

e Listrik yang digunakan lebih hemat.

e Software lebih meningkat.

e Harga makin terjangkau.

e Kapasitas memori lebih besar.

e Kecepatan menggunakan IC sehingga kinerja komputer lebih cepat.

e Memiliki kecepatan 10.000 kali lebih cepat di banding generasi
pertama.

e Komputer dapat melakukan multiprocessing.

e Komputer sudah menggunakan visual display dan dapat
mengeluarkan suara.

e Menggunakan penyimpanan eksternal, seperti disket magnetic.

e  Mampu melakukan komunikasi dengan komputer lain.
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Gambar 2.3: Komputer Generasi Ketiga Integrated Circuit (1965 — 1971)

2.10.4 Komputer Generasi Keempat Microprosesor (1971
— Sekarang)

Komputer yang kita pakai sekarang merupakan komputer generasi keempat,
yang mana dibuat dengan menggunakan komponen dasar bernama
Microprosesor. Chip microprosesor memiliki ribuan transistor dan beberapa
macam elemen sirkuit yang mana saling terhubung menjadi satu. Intel menjadi
sebuah perusahaan yang paling berpengaruh terhadap perkembangan chip
microprosesor karena mereka berhasil menciptakan intel 4004 yang
merupakan cikal bakal perkembangan komputer. Perusahaan dari Intel berhasil
menggantikan perangkat komputer yang memiliki ukuran yang besar menjadi
sangat kecil sehingga menjadikannya lebih efisien.

Pada tahun 1971, IBM menciptakan komputer yang didesain khusus untuk
kalangan rumahan. Sedangkan Apple mempublikasikan Macinthos untuk
pertama kalinya pada tahun 1984, yaitu sebuah sistem operasi agar dapat
dijalankan dari perangkat komputer. Banyak sekali kemajuan pesat yang
terjadi pada generasi ini, seperti diciptakannya mouse, GUI (Graphical User
Interface) hingga komputer jinjing yang disebut dengan laptop. Bahkan
prosesor atau CPU pun mengalami perkembangan dari waktu ke waktu hingga
sekarang.
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Ciri-ciri komputer generasi keempat:

e Dapat menggunakan LSI (Large Scale Integration).

e Sudah memakai semikonduktor dan mikro processor yang berbentuk
seperti chip untuk memorinya.

e Dipasarkan pada sektor perorangan.

e Muncul komputer terbaru yang lebih efisian dan mudah dibawa
kemana pun, seperti laptop.

Gambar 2.4: Komputer Generasi Keempat Microprosesor (1971 — Sekarang)

2.10.5 Komputer Generasi Kelima Artificial Intelligence
(Sekarang — Masa Depan)

Generasi kelima ini sebenarnya masih tahap pembangunan, yang mana
generasi ini akan mempunyai teknologi yang dibuat berdasarkan kecerdasan
buatan (artificial intelligence). Dalam sejarah perkembangan komputer,
pengembangan komputer generasi kelima ini bertujuan agar dapat
menghasilkan perangkat komputer yang dapat merespon, menggunakan
bahasa yang digunakan manusia, diharapkan dapat mempelajari lingkungan di
sekitarnya, serta dapat menyesuaikan dirinya sendiri.

24



Bab 2 Perkembangan Komputer 25

Ciri-ciri komputer generasi kelima:

e Komputer masih menggunakan teknologi LSI namun akan banyak
mengalami proses pengembangan.

e Memiliki fitur yang terus berkembang setiap tahunnya.

e Semakin cepat dalam pemrosesan informasi.

e Komputer memiliki kemampuan untuk mendengar, berbicara,
melihat, berbicara, dan bisa lebih canggih lagi. Bahkan dapat
memberikan kesimpulan layaknya manusia.

Gambar 2.5: Generasi Kelima Atrtificial Intelligence (Sekarang — Masa
Depan)



26

Aplikasi Komputer

26



Bab 3

Hardware/ Perangkat Keras

3.1 Sejarah Perkembangan Komputer

Perangkat komputer secara umum terdiri dari komponen-komponen yang
dibedakan menjadi perangkat keras (Hardware) dan perangkat lunak
(Software), sedangkan perangkat tersebut digunakan secara bersama oleh
pengguna komputer yang sering disebut dengan perangkat pengguna
(Brainware), Supriyanto, (2005) Kumpulan dari software dan hardware yang
digunakan oleh brainware dinamakan sebagai sistem komputer. Jadi sistem
komputer adalah perpaduan antara hardware dan software yang dioperasikan
secara bersama-sama untuk mencapai tujuan tertentu oleh penggunanya.
Hardware komputer adalah perngkat yang secara fisik dapat dilihat dan
disentuh seperti terlihat pada gambar 3.1. Jika dilihat dari luar perangkat keras
merupakan kumpulan dari kotak yang saling terhubung dengan kabel-kabel
elektrik. Banyak komponen hardware yang ada pada seperangkat komputer
(PC), seperti Motherboard (Papan Induk), Processor (Otak Komputer) atau
sering disebut CPU (Central Processing Unit), Memory (RAM/ROM),
Harddisk, Diskdrive, Diskket, CD-R atau R/W, Card (kartu), beberapa IC
(Integrated Circuit), dan kabel-kabel yang biasanya terdapat dalam casing box
(Orang bisa menyebut CPU). Dan hardware yang biasa tampak diluar seperti
Monitor, Mouse, Keyboard, dan biasanya ditambah dengan perangkat(Device)
yang terhubung tang umum dipakai seperti printer dan lain sebagainya.
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Gambar 3.1: Peronal Komputer

Perangkat keras komputer secara fungsional dibedakan menjadi empat macam
perangkat (device), yaitu :

e Peragkat Masukan (Input Device),
e Perangkat Proses (Process Device),
e Perangkat Keluaran (Output Device) dan,

3.1.1 Perangkat Masukkan (Input Device)

Perangkat masukkan merupakan alat yang digunakan untuk menerima
masukkan yang dapat berupa masukkan data atau program. Beberapa alat
masukkan mempunyai fungsui ganda, yaitu sebagai alat masukkan dan
sekaligus sebagai alat keluaran (Output) untuk menampilkan hasil.

a. Keyboard

(Sugiaharto, 2010) Keyboard merupakan alat input yang paling umum
digunakan, input dimasukkan ke alat proses dengan cara mengetik lewat
penekanan kumpulan tombol tekan on-off yang dapat digunakan secara
kombinasi maupun terpisah. Yang ada di keyboard. Dari beberapa jenis
keyboard yang beredar dipasaran (khususnya Indonesia) adalah jenis
American standard, British standard, dan Japan.
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Secara fisik, keyboard terbagi atas 4 bagian, yaitu:

e Keyboard Serial

e Keyboard PS/2

e Keyboard Wireless
e Keyboard USB

Umumnya orang yang sudah familiar dengan layout keyboard yang disebut
dengan “QWERTY?”, yaitu susunan huruf tombol kiri atas. Rancangan
keyboard ini pertama kali digunakan pada mesin ketik di USA tahun 1874.
Susunan tombol dipilih untuk mengurangi loncatan penekanan tmbol yang
tidak sengaja pada mesin ketik manual. Misal ‘s’, ‘t’, dan ‘h’ diletakkan
berjauhan meskipun sering digunakan bersama dalam kalimat bahasa Inggris.

QWERTY

TP TT ET LT T TTEF
= L0 (3 LS L O i A
| 3 N 0 G O G Y D ) N
| (0 I 0 K 2031 R I3 6
=171 |B N

Gambar 3.2: layout Keyboard Querty

b. Pointing devices

Dalam kebutuhan tertentu misalnya pada pembuatan grafik, memilih icon

dilayar, shooting pada games, dll, penggunaan keyboard dirasakan memang

tidak praktis, sehingga ada alat lain yang lebih mudah digunakan yaitu pointing

device seperti Mouse, touch screen, light pen, stylus, digitizer graphic tablet.

1. Mouse
Mouse yang dalam bahasa Indonesia berarti “tikus” (disebut seperti
ini karena bentuk dan kabel yang terdapat pada mouse benar-benar
menyerupai tikus), berfungsi untuk membantu dalam memeberikan
perintah kepada komputer dalam bentuk pointer yang digunakan
untuk mengarahkan posisi cursor dilayar, mouse mengikuti gerakan
tangan manusia.
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Secara fisik, mouse juga terbagi atas 4, yaitu :
e Mouse Serial
e Mouse PS/2
e  Mouse Wireless
e Mouse USB
2. Light pen
Menyentuh layar monitor dengan pena khusus menggunakan light
sensitive (photo electric) contoh : stylus pada PDA, Laptop.
3. Touch screen (layar sentuh)
Merupakan layar monitor yang akan mengaktifkan program bila
layarnya disentuh dengan tangan, (menggantikan mouse/ keyboard).
4. Digital graphic tablet
Membuat grafik dengan menghubungkan kedua titik atau
menggambar langsung pada pad khusus dengan pen khusus dan
hasilnya akan fitampilkan pada layar contoh : Pad menggambar
5. Joystick

Pengguna pada game akan amat membutuhkan perangkat ini, karena
akan memudahkan mereka melakukan manuver-manuver yang sulit

dilakukan oleh penggunaan keyboard dan mouse.

Ne

Mouse

Touch Screen

oL

et

-

Digéal Graphs Tablt ” Joystick

Gambar 3.3: Pointing Device
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c. Scanner

Scanner berfungsi untuk memasukkan data gambar ke dalam komputer dan
memiliki prinsip kerja yang sama dengan mesin photo copy. Secara umum,
scanner terbagi atas 2, yaitu flatbed scanner dan handled scanner.

Gambar 3.4: Scanner

3.1.2 Perangkat Proses (Process Device)

Perngkat Pemroses atau pengolah data dalam komputer adalah prosesor
(processor). Namun umumnya pengguna komputer menyebutnya sebagai
CPU (Central Processor Unit). CPU merupakan otak bagi sebuah sistem
komputer.

Contoh bagian-bagian CPU adalah :
a. Motherboard

Hidayat, (2013) Motherboard (sering disebut juga mainboard) diibaratkan
sebuah kota yang berisi gedung-gedung, rumah, jalan-jalan raya, beserta
infrastruktur lainnya. Secara sederhana sebuah MB berisi: PCB utama,
Processor Socket/Slot, Memory Slot, PCL Slot, IDE slot, Chipset, BIOS, 1/0
Connector (Parallel,Serial Sound,USB,PS/2), Power Connector dan beberapa
komponen elektronis lain. Pengertian Slot dan Connector adalah tempat di
mana device lain dapat di instalasikan sesusai standartnya masing-masing.
Misalnya processor akan di install pada processor socket, memory pada
memory socket, sound-card pada PCL slot atau keyboard yang bisa dipasang
pada port USB atau PS/2. Motherboard merupakan papan utama yang
berfungsi untuk menyediakan tempat (socket, slot, dan connector) bagi
komponen-komponen tersebut, motherboard terdapat komponen-komponen
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chip controller yang bertugas mengatur lalu lintas data dalam sistem
motherboard serta mengatur pemberian daya listrik pada setiap komponen PC.
Pada motherboard terdapat socket untuk processor, memory dan slot-slot yang
digunakan untuk pemasangan komponen kartu seperti VGA card, Sound card,
Internal modem, dan lain-lain.

Fungsi Motherboard:

e Sebagai alat untuk tempat pemasangan komponen-komponen antara
lain processor, memory (RAM), Kartu grafis dan lain-lain sesuai
kebutuhan.

e Meghubungkan komponen-komponen dalam CPU dengan
menggunakan kabel atau langsung ditancap ke socket, slot yang
terdapat di mainboard.

e Pusat pengendalian yang mengatur kerja dari semua komponen yang
terpasang di motherboard.

e Mengatur pemberian daya listrik pada setiap komponen di PC.

e Mengatur lalu lintas semua data, mulai dari peranti penyimpanan
(Harddisk, memori), peranti masukkan data (keyboard, mouse,
scanner), atau printer untuk mencetak.

Gambar 3.5: Layout Mntherboard

b. Processor

Processor sering disebut sebagai otak dan pusat pengendalian komputer yang
didukung oleh komponen lainnya. Prosesor adalah sebuah IC yang mengontrol
keseluruhan jalannya sebuah sistem komputer dan digunakan sebagai pusat
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atau otak dari komputer yang berfungsi untuk melakukan perhitungan dan
menjalankan tugas. Prosesor terletak pada socket yang telah disediakan oleh
motherboard, dan dapat diganti dengan prosesor yang lain asalkan sesuai
dengan socket yang ada pada motherboard. Salah satu yang sangat
berpengaruh terhadap kecepatan komputer tergantung dari jenis dan kapasitas
prosesor. Prosessor merupakan chip yang sering disebut dengan
“microprocessor’” yang sekarang prosesor satu ukurannya sudah mencapai
Gigahertz (GHz). Ukuran tersebut adalah hitungan kecepatan prosesor dalam
mengolah data dan informasi. Merk prosesor yang banyak beredar dipasaran
ialah AMD, Apple, Cyrix VIA, IBM, IDT, dan Intel.

Bagian dari prosesor terbagi menjadi 3 yaitu :
e Aritcmatics Logical Unit (ALU)

o Control Unit (CU)
e  Memory Unit (MU)

Gambar 3.6: Processor

c. Memori RAM

Dalam bahasa inggris: Random Access Memory, RAM adalah sebuah tipe
penyimpanan komputer yang isinya dapat diakses dalam waktu yang tepat
tidak memperdulikan letak data tersebut dalam memori ini. RAM berlawanan
dengan alat memori urut, seperti tape magnetik, disk dan drum, di mana
gerakan mekanikal dari media penyimpanan memaksa komputer untuk
mengakses data secara berurutan, Pertama kali ditemukan oleh Robert
Dennard dan diproduksi secara besar-besaran oleh intel pada tahun 1968, jauh
sebelum PC ditemukan oleh IBM pada tahun 1981. Dari sinilah perkembangan
RAM bermula. Pada awal diciptakannya, RAM membutuhkan tegangan 5.0
volt untuk dapat berjalan pada frekuensi 4,77MHz, dengan waktu akses
memori (access time) sekitar 200ns (1ns=10-9 detik).
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Ada banyak jenis RAM di antaranya :

1. DRAM (Dynamic Random Access Memory)

a. Jenis RAM yang menyimpan setiap bit data yang terpisah dalam
kapasitor dalam satu sirkuit terpadu. Data yang terkandung di
dalamnya harus disegarkan terlebih dahulu secara berkala oleh
CPU agar tidak hilang. Hal ini membuatnya sangat dinamis
dibandingkan dengan memori lainnya.

b. Dalam strukturnya, DRAM hanya memerlukan satu transistor
dan kapasitor per bit, sehingga memiliki kepadatan sangat tinggi.
Cirri-ciri dari DRAM hanya mempunyai satu lubang slot. Secara
logika lubang slot pada RAM tidak mempunyai ukuran yang
sama antara kanan dan kiri lubang tersebut.

Gambar 3.7: Memori
2. SRAM (Static Random Access Memory)

Jenis RAM (sejenis memori semikundektor) yang tidak menggunakan
kapasitor. Hal ini mengakibatkan SRAM tidak perlu lagi disegarkan secara
berkala seperti halnya dengan DRAM. Ini juga sekaligus membuatya memiliki
kecepatan lebih tinggi dari DRAM. Berdasarkan fungsinya terbagi menjadi
Asynchronous dan Synchronous. Memori jenis ini langsung menempel ke
motherboard mempunyai kaki kanan dan kiri memori ini ukurannya lebih kecil
dari DRAM.
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RAM (Random Access Memory)”

SRAM - Static RAM yvs. DRAM = Dynamic RAM

Gambar 3.8: Memori DRAM

3. EDO RAM (Extended Data Out Random Access Memory)

a.

EDO RAM merupakan jenis RAM yang datapt menyimpan dan
mengambil isi memori secara bersamaan, sehingga kecepatan
baca tulisnyapun menjadi lebih cepat,

Umumnya digunakan pada PC terdahulu sebagai pengganti Fast
page memori (FPM RAM). Jenis memori ini sama bentuknya
dengan memori DRAM. (Contoh EDO Ram)

Gambar 3.9: Memori EDO RAM

4. SDRAM (Synchronous Dinamic Random Access Memory)

a.

SDRAM merupakan jenis ram dinamis yang kemampuan
kecepatannya lebih tinggi atau lebih cepat disbanding EDO RAM
dan kepingannya terdiri dari 168 pin/kaki

RAM ini disingkronisasi oleh clock system dan cocok untuk
sistem dengan bus yang memiliki kecepatan sampai 100MHz.
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SDRAM mempunyai dua lubang slot yang jarak antara lubang ke
lubang tidak terlalu berantakan. (Contoh SDRAM)

Gambar 3.10: Memori SD RAM

5. RDRAM (Rambus Dynamic Random Access Memory)

a.

Salah satu tipe dari RAM dinamis sinkron yang diproduksi oleh
Rambus Corporation menggunakan bus speed sebesar 800MHz
tetapi memiliki jalur data yang sempit (8bit). RDRAM memiliki
memori controller yang canggih sehingga tidak semua
moherboard bisa mendukungnya.

Contoh produk yang memakainya adalah 3DVX seri Voodoo4.
Jenis memori ini hapir sama dengan memori SDRAM, hanya saja
beda jarak antara lubang slot. Memori ini mempunyai lubang slot
yang lebih dekat. (Contoh RDRAM)

Gambar 3.11: Memori RDRAM
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d. Harddisk

Harddisk adalah piranti penyimpanan sekunder di mana data disimpan sebagai
pulsa magnetic pada piringan metal yang berputar terintegrasi. Data disimpan
dalam lingkaran konsentris disebut track. Tiap track dibagi dalam beberapa
segment yang dikenal sebagai sector. Untuk melakukan operasi baca tulis data
dari dan ke piringan, harddisk menggunakan head untuk melakukannya, yang
berada di setiap piringan. Head inilah yang selanjutnya bergerak mencari
sector-sector tertentu untuk dilakukan operasi terhadapnya. Waktu yang
diperlukan untuk mencari sector disebut seek time. Setelah menemukan sector
yang diinginka, maka head akan berputar untuk mencari track. Waktu yang
diperlukan untuk mencari track ini dinamakan latency. Dalam bentuknya
sendiri, harddisk memiliki jenis-jenis yang perlu diperhatikan.

Beberapa di antaranya adalah :

a. IDE
Jenis Hrddisk IDE (Integrated Drive Electronics) merupakan standar
interface antara bus data motherboard komputer dengan disk storage.
IDE interface dibuat berdasarkan IBM PC Industry Standard
Architecture (ISA) 16-bit bus. Interface dari IDE adalah interface
untuk storage devices yang dapat teringrasi untuk disk atau CD-ROM
drive.

b. SATA
Jenis hardisk SATA dengan 15 pin kabel power dengan 250Mv,
tampaknya memerlukan daya lebih banyak dibandingkan dengan 4
pin ATA tapi dalam kenyataannya sama saja. Dan kemampuan
SATA yang paling bagus adalah tercapainya maximum bandwith
yang mungkin yaitu sebesar 150MB/sec.

Keuntungan lainnya dari SATA adalah Sata dibuat dengan kemampuan hot-
swap sehingga dapat mematikan dan menyalakan tanpa melakukan shutdown
pada sistem komputer. (Contoh Harddisk Sata)
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Gambar 3.12: Hardisk SATA

c. ATA

Kebanyakan type drive yang digunakan oelh para pengguna
komputer adalah tipe ATA (dikenal dengan IDE drive). Tipe ATA
dibuat berdasarkan standar tahun 1986 dengan menggunakan 16 bit
parallel dan terus berkembang dengan penambahan kecepatan
transfer dan ukuran sebuah disk. Standart terakhir adalah ATA-7
yang dikenalkan pertama kali pada tahun 2001 oleh komite T13
(komite yang bertanggung jawab menentukan standart ATA). Tipe
ATA -7 memiliki data transfer sebesar 133 MB/sec. kemudian selama
tahun 2000 ditentukan standar untuk parallel ATA yang memiliki
data rate sebesar 133 MB/sec, tapi parallel ATA terdapat banyak
masalah hal signal timin, EMI (elektromognetic interference) dan
intergritas data. (Contoh Harddisk Ata)

Gambar 3.13: Hardisk ATA
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3.1.3 Perangkat Keluaran (Output Device)

Perangkat Keluaran merupakan perangkat yang dipakai untuk menampilkan
hasil proses. Contohnya seperti layar monitor, printer, plotter, display, card dan
speaker. Perangkat output atau perangkat kelusran merupakan perangkat yang
terdiri dari alat-alat yang menterjemahkan perintah yang telah diproses oleh
komputer dalam bentuk yang telah dimengerti oleh manusia. Data atau
perintah yang telah diproses oleh komputer biasanya dalam bentuk kode
binary yang diwakili oleh angka O dan 1 yang perlu diterjemahkan kepada
bentuk yang lebih dipahami dan berguna untuk manusia. Terdapat dua jenis
perangkat Output yang utama yaitu bersifat softcopy dan hardcopy. Softcopy
misalnya Monitor dan Audio, kemudian Hardcopy misalnya Printer.

1. Layar Tampilan (Monitor)

Terdapat 2 jenis unit layar tampilan yang biasa digunakan untuk komputer

yaitu :

a. Layar Monitor berbentuk Pipih atau sering disebut LCD (Liquid
Crystal Display) atau Monitor Kristal cair, yang kebanyakan
digunakan pada komputer Notebook, namun saat ini juga sudah mulai
dipakai untuk PC. Jenis LCD biasa, berteknologi model penyinaran
belakang (backlit) dan penyinaran samping (sidelit). LCD TFT (thin-
film transistor) atau matriks aktif, setiap pixel dikendalikan oleh satu
transistor. (Contoh gambar monitor LCD)

Gambar 3.14: Monitor LCD
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b. Layar Monitor Tabung atau disebut juga CRT (Cathode Ray Tube)
bentuknya seperti layar televisi yang digunakan untuk komputer jenis
Desktop atau PC. Monitor CRT jenisnya monochrome dan warna.
Monochrome warna yang paling populer adalah hijau, kuning dan
putih. Setiap pixel terdiri dari satu dot (satu titik), sehingga
memberikan image yang lebih tajam. Sedangkan monitor warna
ditentukan oleh phosphor pada layar CRT. Setiap pixel terbentuk dari
tiga dot. Monitor monochrome mempunyai phosphor warna tunggal
(putih). Monitor warna menggunakan gabungan tiga phosphor
berwarna merah, hijau dan biru(Red-Green, Blue/ RGB). Gabungan
tiga phosphor membentuk satu pixel. Maka terdapat tiga pancaran
bagi tiga warna yang menembak dengan kekuatan-kekuatan lain
untuk membentuk warna-warna yang berlainan. (Contoh gambar
monitor CRT)

Gambar 3.15: Monitor CRT
2. Speaker

Fungsi Speaker pada komputer adalah sama dengan fungsi speaker pada
perangkat audio sistem. Yang membedakan secara garis besar hanyalah pada
ukurannya. Speaker pada komputer dibuat seefisien mungkin agar tida terlalu
memerlukan banyak tempat. Namun pengguna tertentu terkadang
menghubungkan output sound mereka pada perangkat speaker lainnya untuk
lebih memberikan kepuasan yang lebih.
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3.

Gambar 3.16: Speaker

Printer

Printer dan Plotter merupakan perangkat pencetak (Hardcopy) yang dihasilkan
dari hasil pemrosesan komputer dan input dari penggunanya. Jenis cetakan
juga dalam bentuk kertas bercetak, transparansi ataupun “wax thermal paper”.

Terdapat tiga macam jenis hasil cetakan dari printer :

a.

*Printer Dot-matrik. Pencetakan ini mempunyai pengetuk kecil
berbentuk titi yang dinamai pin. Pencetak Dot-matrix 9 pin berarti
pengetukannya 5 titik (dot) melintang dan 7 titik dari atas kebawah.
Dot-matrix 24 pin juga mengetuknya secara berulang-ulang sehingga
hasilnyanampak lebih padat. Ia juga bisa menghasilkan cetakan
warna dengan sekurang-kurangnya 3 warna. Meskipun kualitas
hasilnya kurang bagus, namun kelebihan printer ini adalah sekaligus
dapat mencetak pada kertas lebih dari satu pada kertas karbon.

Printer Tinta. Bekerja dengan cara menyemprotkan atau
menyemburkan tinta yang ada di dalam cardrige kekertas. Hasil
cetakan akan lebih baik daripada printer Dot-matrik karena lebih
halus. Namun hasil semprotan kkertas juga tergantung pada kualitas
tinta dan printer yang digunakan. Hasil yang kurang bagus akan
menjadikan semprotan pada kertas tidak cepat kering dan bisa
menimbulkan noda pada kertas.

Printer Laser. bekerja seperti mesin photocopy yang menyemprotkan
serbuk tinta dengan model pencahayaan, kualitas hasil printer laser
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paling bagus namun harga printer dan serbuk tintanya juga paling
mabhal.
d. Plotter sebenarnya hampir sama dengan printer, namun biasanya

digunakan untuk mencetak gambar, grafik, desain teknik yang
ukurannya besar.

& &8 =

\
Gambar 3.17: Printer Dot matrik (Kiri), Printer Tinta (Tengah), dan
Printer Laser (Kanan)



Bab 4
Software/Perangkat Lunak

4.1 Pengertian Software

Perangkat keras atau hardware ada bentuk fisiknya, sebaliknya kalau perangkat
lunak tidak ada bentuk fisiknya. Perangkat lunak atau software komputer
memiliki pengertian sebagai sekumpulan data elektronik, yang tersimpan dan
kemudian dikendalikan oleh perangkat komputer. Nah, data elektronik tersebut
berupa Instruksi atau program, yang nantinya akan menjalankan perintah
khusus. Jadi dalam sebuah perangkat komputer atau laptop harus diinstal
software, agar bisa dioperasikan. Oleh karena itu, di setiap komputer bisa
terpasang software yang berbeda-beda. Sebab instalasi perangkat lunaknya
disesuaikan dengan keinginan penggunanya.

4.2 Macam-Macam Software

Ada beragam jenis perangkat lunak yang bisa dioperasikan pada komputer.
Untuk bisa menggunakannya terdapat software berbayar dan tak berbayar.
Nabh, apa saja macam perangkat lunaknya?

1. Perangkat Lunak Berbayar

Sangat banyak produk software yang dikembangkan oleh developernya.
Namun, untuk bisa menikmati kegunaan perangkat lunak tersebut, serta
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berbagai fitur dan update terbarunya, anda harus membayar dengan harga
tertentu. Meskipun anda sudah membelinya, tapi tidak mendapatkan lisensi
untuk membuat copiannya dan menyebarluaskan untuk pengguna komputer
lain. Karena tindakan itu termasuk ilegal dan bertentangan dengan hukum.
Produk perangkat lunak ini seperti :

e  Microsoft Windows,

e Adobe Photosoft,

e (Corel Draw,

e Microsoft Office, dan sebagainya.

2. Freeware

Perangkat lunak ini bersifat gratis, jadi tidak harus membelinya seperti
software berbayar. Bahkan anda bisa menggunakannya tanpa batasan waktu.
Jadi bisa digunakan tanpa berbayar sampai kapan pun.

Biasanya pengembang software ini mendedikasikannya untuk komunitas
tertentu. Tetapi hak cipta tetap dipertahankannya, sehingga tetap bisa juga
melakukan berbagai pengembangan selanjutnya. Contoh produk dari freeware
ini adalah :

e Google Chrome,

e Mozilla Firefox, dan sebagainya.

3. Free Software

Pada awalnya anda harus membeli perangkat lunak ini. Namun, anda bebas
untuk melakukan penggandaan, modifikasi bahkan distribusinya. Jadi
pengertian gratisnya tidak hanya pada beberapa komponen tersebut. Inilah
yang membedakannya dengan freeware.

4. Shareware

Perangkat lunak ini juga bisa digunakan secara gratis. Sayangnya ada batasan
waktu untuk penggunaannya. Inilah perbedaannya dengan freeware, yang bisa
dimanfaatkan selamanya tanpa ada waktu kadaluarsanya. Shareware
merupakan program khusus yang didistribusikan sebagai software versi
evaluasi atau demonstrasi. Oleh karena itu, pengembangnya membatasi fungsi
atau fitur yang bisa digunakan penggunanya. Jadi pengembangkan akan
membatasi waktu pemakaiannya, semisal hanya satu bulan saja. Nah, bila anda
ingin menikmati seluruh fiturnya, maka harus membelinya terlebih dahulu.

Cara ini dimanfaatkan sebagai pengujian produk, sehingga anda bisa
mengetahui beragam kelebihan dan fungsi yang ditawarkannya. Shareware ini
biasanya dimanfaatkan oleh perusahaan pengembang anti virus. Itulah kenapa
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anda sering mendapatkan uji coba penggunaan antivirus secara gratis, tapi
hanya dalam tempo waktu tertentu saja. Sesudah itu tertarik dengan
antivirusnya dengan segala fitunya, maka anda harus membayar dalam
jumlah tertentu. Itulah kenapa shareware juga dikenal juga dengan istilah
trialware.

5. Malware
Perangkat lunak ini dianggap sebagai perusak sehingga berbahaya bila
disalahgunakan. Tujuan pembuatan software ini memang untuk menyusup
bahkan merusak sistem jaringan komputer. Tentunya tanpa seizin dari
pemiliknya. Istilah malware sudah umum digunakan sebagai penamaan bagi
perangkat lunak yang bisa mengganggu perangkat komputer. Contoh produk
malware meliputi spyware (perangkat lunak pengintai), adware (perangkat
lunak untuk iklan yang tidak transparan atau tidak jujur), virus komputer dan
sebagainya sebagai software yang dibuat dengan tujuan jahat. Contoh lainnya
adalah software Bancos, yang bisa mencuri data dari komputer orang lain. Jadi
saat penggunanya membuka website bank, maka software ini akan melakukan
kamuflase atau mengalihkannya ke situs bank phising atau palsu. Sehingga
seluruh data nasabah bisa dicuri dengan bantuan malware tersebut.
6. Open Source Software
Sesuai namanya perangkat lunak ini bersifat terbuka, sehingga anda bisa
mengaksesnya secara gratis. Sesuai namanya, maka kode sumbernya terbuka
agar bisa dipelajari, kemudian dimodifikasi agar fungsinya meningkat, dan
seterusnya boleh disebarluaskan untuk pengguna lainnya. Jadi perangkat lunak
ini biasanya dikelola oleh komunitas tertentu. Meskipun sifatnya terbuka, tapi
tetap harus digunakan sesuai dengan ketentuan dan etika tertentu. Contoh dari
perangkat lunak ini adalah Linux, yang fungsinya setara dengan Microsoft
Windows. Beberapa Aplikasi Open-Source dan Free/Gratis yang sering
digunakan

Tabel 4.1: Sistem Operasi

Sistem Operasi (Operating System)

CentOS alias Community ENTerprise Operating System
% adalah sebuah distro Linux yang diturunkan dari RHELJ
‘7 —> |(Red Hat Enterprise Linux). CentOS dibuat oleh North
d American Enterprise Linux. Namun berbeda dengan
turunan Linux lainnya, CentOS merupakan copian dari
CentOS  |RHEL 99%. Mengapa?
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Karena CentOS hanya membuang label RH dan diganti
dengan label generic. Jadi isi dari program CentOS sama
dengan RHEL. Drivers yang jalan di RHEL otomatis jalan
juga di CentOS.

Meskipun keberadaan CentOS sangar tergantung pada Red
Hat namun hal ini justru memberikan nilai tambah, karena
RH merupakan satu-satunya distro komersial Linux yang
dipakai secara luas di perusahaan besar dan satu-satunya
distro Linux yang didukung oleh CPanel (CPanel adalah
kontrol panel terbanyak dipakai oleh perusahaan hosting,
hampir 100% hosting menggunakan CPanel). Karena
merupakan copian RHEL maka CentOS juga didukung
secara resmi oleh CPanel.

'Website: http://www.centos.org/

debian

Debian adalah sistem operasi bebas yang dikembangkan
secara terbuka oleh banyak programer]
sukarela(pengembang Debian) yang tergabung dalam
Proyek Debian. Sistem operasi Debian adalah gabungan
dari perangkat lunak yang dikembangkan dengan lisensi
GNU, dan utamanya menggunakan kemel Linux, sehingga
populer dengan nama Debian GNU/Linux. Sistem operasi
Debian yang menggunakan kemel Linux yang merupakan
salah satu distro Linux yang populer dengan kestabilannya.
Rata-rata Distro turunan Debian adalah Distro yang paling
banyak digunakan di dunia, seperti ; Ubuntu , Linux Mint |
Backtrack , Knoppix.

'Website: http://www.debian.org/

®

ubuntu

Ubuntu (play /u'buntu:/) merupakan salah satu distribusi
Linux yang berbasiskan Debian dan didistribusikan sebagai
perangkat lunak bebas. Nama Ubuntu berasal dari filosofi
dari Afrika Selatan yang berarti "kemanusiaan kepadd
sesama"[6]. Ubuntu dirancang untuk kepentingan
penggunaan pribadi, namun versi server Ubuntu juga
tersedia, dan telah dipakai secara luas.

Proyek Ubuntu resmi disponsori oleh Canonical Ltd. yang

merupakan sebuah perusahaan yang dimiliki oleh
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pengusaha Afrika Selatan Mark Shuttleworth. Tujuan dari
distribusi Linux Ubuntu adalah membawa semangat yang
terkandung di dalam filosofi Ubuntu ke dalam dunia
perangkat lunak. Ubuntu adalah sistem operasi lengkap
berbasis Linux, tersedia secara bebas, dan mempunyai
dukungan baik yang berasal dari komunitas maupun tenagaj
ahli profesional

‘Website: http://www.ubuntu.com/

'Web Server

APRPACHE

Server HTTP Apache atau Server Web/WWW  Apachg
adalah server web yang dapat dijalankan di banyak sistem
operasi (Unix, BSD, Linux, Microsoft Windows dan|
Novell Netware serta platform lainnya) yang berguna untuk
melayani dan memfungsikan situs web. Protokol yang
digunakan untuk melayani fasilitas web/www inj
menggunakan HTTP.

Apache memiliki fitur-fitur canggih seperti pesan kesalahan
yang dapat dikonfigur, autentikasi berbasis basis data dan
lain-lain. Apache juga didukung oleh sejumlah antarmuka
pengguna berbasis grafik (GUI) yang memungkinkan
penanganan server menjadi mudah.

Apache merupakan perangkat lunak sumber terbuka
dikembangkan oleh komunitas terbuka yang terdiri darij
pengembang-pengembang dibawah naungan Apache
Software Foundation.

‘Website: http://httpd.apache.org[

Bahasa Pemrograman

PHP adalah singkatan dari "PHP: Hypertext Prepocessor”)
yaitu bahasa pemrograman yang digunakan secara luas
untuk penanganan pembuatan dan pengembangan sebuah
situs web dan bisa digunakan bersamaan dengan HTML.
PHP diciptakan oleh Rasmus Lerdorf pertama kali tahun
1994. Pada awalnya PHP adalah singkatan dari "Personal

/ [Home Page Tools". Selanjutnya diganti menjadi FI

("Forms Interpreter"). Sejak versi 3.0, nama bahasa ini

diubah menjadi "PHP: Hypertext Prepocessor”" dengan
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singkatannya "PHP". PHP versi terbaru adalah versi ke-5
Berdasarkan survey Netcraft pada bulan Desember 1999
lebih dari sejuta site menggunakan PHP, di antaranya
adalah NASA, Mitsubishi, dan RedHat.

'Website: http://www.php.net/

g

T
e
s

= —

Java

Java adalah bahasa pemrograman yang dapat dijalankan di
berbagai komputer termasuk telepon genggam. Bahasa ini
awalnya dibuat oleh James Gosling saat masih bergabung
di Sun Microsystems saat ini merupakan bagian dari Oraclg
dan dirilis tahun 1995. Bahasa ini banyak mengadopsi
sintaksis yang terdapat pada C dan C++ namun dengan
sintaksis model objek yang lebih sederhana serta dukungan
rutin-rutin aras bawah yang minimal. Aplikasi-aplikasi
berbasis java umumnya dikompilasi ke dalam p-code
(bytecode) dan dapat dijalankan pada berbagai Mesin
Virtual Java (JVM).

Java merupakan bahasa pemrograman yang bersifat
umum/non-spesifik (general purpose), dan secara khusus
didisain untuk memanfaatkan dependensi implementasi
seminimal mungkin. Karena fungsionalitasnya yang
memungkinkan aplikasi java mampu berjalan di beberapa
platform sistem operasi yang berbeda, java dikenal pula
dengan slogannya, "Tulis sekali, jalankan di mana pun"|
Saat ini java merupakan bahasa pemrograman yang paling]
populer digunakan, dan secara luas dimanfaatkan dalam
pengembangan berbagai jenis perangkat lunak aplikasi
ataupun aplikasi berbasis web.

Website : http://www.java.com/en/

Sistem Manajemen Basis Data (Database Management System)

N,

MySau

MySQL adalah sebuah perangkat lunak sistem manajemen
basis data SQL (bahasa Inggris: database management
system) atau DBMS yang multithread, multi-user, dengan
sekitar 6 juta instalasi di seluruh dunia. MySQL AB
membuat MySQL tersedia sebagai perangkat lunak gratis
dibawah lisensi GNU General Public License (GPL), tetapi

mereka juga menjual dibawah lisensi komersial untuk
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kasus-kasus di mana penggunaannya tidak cocok dengan
penggunaan GPL.

Tidak sama dengan proyek-proyek seperti Apache, di mana
perangkat lunak dikembangkan oleh komunitas umum, dan
hak cipta untuk kode sumber dimiliki oleh penulisnya
masing-masing, MySQL dimiliki dan disponsori oleh
sebuah perusahaan komersial Swedia MySQL AB, di mana|
memegang hak cipta hampir atas semua kode sumbemya,
Kedua orang Swedia dan satu orang Finlandia yang
mendirikan MySQL AB adalah: David Axmark, Allan
Larsson, dan Michael "Monty" Widenius.

Website: http://dev.mysql.com/

PostgreSQL

PostgreSQL adalah sebuah sistem basis data yang
disebarluaskan secara bebas menurut Perjanjian lisensi
BSD. Piranti lunak ini merupakan salah satu basis data
yang paling banyak digunakan saat ini, selain MySQL dan
Oracle. PostgreSQL menyediakan fitur yang berguna untuk]
replikasi basis data. Fitur-fitur yang disediakan PostgreSQL
antara lain DB Mirror, PGPool, Slony, PGCluster, dan lain-{
lain.

PostgreSQL adalah sistem database yang kuat untuk urusan
relasi, open source. Memiliki lebih dari 15 tahun
pengembangan aktif dan sudah terbukti segala rancangan
arsitekturnya telah mendapat reputasi tentang “kuat”)
“‘handal”, “integritas data”, dan “akurasi data”

'Website: http://www.postgresql.org/

%Ql,itc

SQLite merupakan sebuah sistem manajemen basisdatal
relasional yang bersifat ACID-compliant dan memiliki
ukuran pustaka kode yang relatif kecil, ditulis dalam bahasa
C.SQLite merupakan proyek yang bersifat public domain
yang dikerjakan oleh D. Richard Hipp.Tidak seperti pada
paradigma client-server umumnya, Inti SQLite bukanlah
sebuah sistem yang mandiri yang berkomunikasi dengan
sebuah program, melainkan sebagai bagian integral dari
sebuah program secara keseluruhan. Sehingga protokoll

komunikasi utama yang digunakan adalah melalui
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pemanggilan API secara langsung melalui bahasa
pemrograman. Mekanisme seperti ini tentunya membawa
keuntungan karena dapat mereduksi overhead, latency
times, dan secara keseluruhan lebih sederhana. Seluruh|
elemen basisdata (definisi data, tabel, indeks, dan data
disimpan sebagai sebuah file. Kesederhanaan dari sisi
disain tersebut bisa diraih dengan cara mengunci
keseluruhan file basis data pada saat sebuah transaksi
dimulai.

‘Website : http://sqlite.org/

Framework Programming

) yii

framework

Yii adalah framework (kerangka kerja) PHP berbasisA
komponen, berkinerja tinggi untuk pengembangan aplikasi
Web  berskala-besar.  Yii menyediakan reusability
maksimum dalam pemrograman Web dan mampu
meningkatkan kecepatan pengembangan secara signifikan|
Nama Yii (dieja sebagai /i:/) singkatan dari "Yes It Is!".

Yii merrupakan framework pemrograman umum Web
yang bisa dipakai untuk mengembangkan semua jenis
aplikasi Web. Dikarenakan sangat ringan dan dilengkapi
dengan mekanisme caching yang canggih, Yii sangat cocok
untuk pengembangan aplikasi dengan lalu lintas-tinggi,
seperti portal, forum, sistem manajemen konten (CMS),
sistem e-commerce, dan lain-lain.

'Website: http://www.yiiframework.com/

4
¢)

Codelgniter

Codelgniter adalah aplikasi open source yang berupa
framework dengan model MVC (Model, View, Controller
untuk membangun website dinamis dengan menggunakan
PHP. Codelgniter memudahkan developer untuk membuat
aplikasi web dengan cepat dan mudah dibandingkan
dengan membuatnya dari awal. Codelgniter dirilis pertama
kali pada 28 Februari 2000.

Framework secara sederhana dapat diartikan kumpulan dari
fungsi-fungsi/prosedur-prosedur dan class-class untuk]
tujuan tertentu yang sudah siap digunakan sehingga bisa

lebih mempermudah dan mempercepat pekerjaan seorang]
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programer, tanpa harus membuat fungsi atau class dari
awal.

‘Website : http://ellislab.com/codeigniter

node

Node.js adalah platform yang dibangun atas JavaScrip{
runtime Chrome untuk membuat aplikasi jaringan dengan
peforma tinggi dan skalabel. Node.js menggunakan I/O
model non-blocking serta event-driven, yang membuatnya
ringan serta effisien, sehingga tepat untuk aplikasi data-
intensive real-time yang berjalan di perangkat terdistribusi.

Website : http://nodeis.org[

[Aplikasi Perkantoran dan Word Processor

™5 Apache
"““Tj OppenOffice'~

Apache OpenOffice (dahulu OpenOffice.org) adalah
sebuah paket aplikasi perkantoran berkode sumber terbukaj
(open source) yang dapat diperoleh secara gratis. Pakef
tersebut termasuk komponen-komponen pengolah kata
(word processor), lembar kerja (spreadsheet), presentasi,|
ilustrasi vektor, dan gudang data (database). Apachg]
OpenOffice ditujukan sebagai saingan bagi Microsofy
Office dan dapat dijalankan di atas berbagai platform, dj
antaranya Windows, Solaris, Linux, dan Mac OS X|
Apache OpenOffice mendukung standar dokumen terbuka
untuk pertukaran data, dan dapat digunakan tanpa biaya.

Apache OpenOffice dibuat berdasarkan kode dari
StarOffice, sebuah office suite yang dikembangkan oleh
StarDivision dan diakuisisi oleh Sun Microsystems padal
[Agustus 1999, yang kemudian diakuisisi oleh Oracle pada
tahun 2010. Pada tahun 2011, proyek ini dikembangkan
oleh Apache Software Foundation. Kode sumber dari suitg
ini dilepas sebagai proyek sumber terbuka pada Juli 2000,
dengan tujuan mendobrak dominasi pasar dari Microsof
Office dengan menyediakan pilihan yang berbiaya rendah,
berkualitas tinggi, dan terbuka. Kode asal untuk suite
aplikasi ini tersedia dibawah dua lisensi perangkat lunak]
yang berbeda: LGPL dan SISSI; dari versi 2.0 sampai versi
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3.3, dia hanya tersedia di bawah LGPL; dari versi 3.4, dig
tersedia di bawah Apache License.

'Website : http://openoffice.org/

LibreOffice

The Document Foundation

LibreOffice adalah sebuah paket aplikasi perkantoran yang
kompatibel dengan aplikasi perkantoran seperti Microsoft
Office atau OpenOffice.org dan tersedia dalam berbagai
platform. Tujuannya adalah menghasilkan aplikasi
perkantoran yang mendukung format ODF tanpa
bergantung pada sebuah pemasok dan keharusan
mencantumkan hak cipta. Nama LibreOffice merupakan
gabungan dari kata Libre (bahasa Spanyol dan Perancig
yang berarti bebas) dan Office (bahasa Inggris yang berarti
kantor).

Sebagai sebuah perangkat lunak bebas dan gratis)
LibreOffice bebas untuk diunduh, digunakan, dan
didistribusikan. ~ LibreOffice ~ merupakan  proyek
pengembangan dari OpenOffice.org yang sejak tahun 2010
sudah diakuisisi oleh Oracle. Semua fitur yang ada dji
OpenOffice ada pula di LibreOffice tetapi ke depannya
akan dikembangkan secara lebih terbuka dan mandirj
karena dibawah naungan pengembang nirlaba.

‘Website : http://www.libreoffice.org/

|Content

Management System|

Drupal adalah sebuah perangkat lunak sistem manajemen
konten yang bebas dan terbuka yang di distribusikan
dibawah lisensi GPL, pengembangan dan perawatannya
dilakukan oleh ribuan komunitas pengguna dan
pengembang di seluruh dunia. Dibuat dengan bahasa
pemrograman PHP, Drupal dapat dipasang pada beberapa
jenis database seperti MySQL, PostgreSQL, SQLite, Marial
DB dan juga MsSQL. Web server yang mendukung di
antaranya Apache, Nginx, IIS yang berjalan pada sistem
operasi Cross-platform seperti Microsoft Windows, Mad

OS X, Linux dan FreeBSD. Drupal dapat diunduh secara|
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bebas dan dapat digunakan secara bebas, sehingga
memungkinkan setiap orang baik secara individu maupun
komunitas untuk mempublikasi, mengatur, mengelola dan
mengorganisir berbagai jenis dari isi/konten pada website|
Kemampuannya tidak sekedar sebagai CMS, namun
dengan modul API-nya Drupal juga dapat digunakan
sebagai CMF dalam membangun aplikasi berbasis Web.

'Website : http://drupal.org/

Alfresco adalah sebuah teknologi content management
system (CMS) sebagai mekanisme mengelola content baik]
itu file multimedia, file dokumen perkantoran, ataupun
bentuk fisik dari sistem informasi. Alfresco adalah
teknologi CMS yang berlisensi open source menggunakan
GNU (General Public License), artinya datang dengan
source code yang dapat diubah / referensi pengembangan|
aplikasi serta dapat dimiliki. Beberapa fitur yang
dimilikinya dapat menjadi alternatif solusi terbuka yang
patut diperhatikandalam pemilihan aplikasi CMS.

Alfresco mengutamakan pada Document Management
yang praktis dan mudah digunakan. Alfresco dapat
diintegrasikan dengan portal seperti Liferay dan dapat
menggunakan SSO untuk mempermudah penggunaan
dalam  perusahaan/organisasi.Dengan ~ menggunakan
Alfresco, manajemen dokumen dalam organisasi menjadi
lebih terstruktur dan mudah dilacak keberadaannya.
Alfresco juga memudahkan untuk berbagi dokumen dan
o Alfresco  |melacak perubahan yang terjadi pada satu dokumenj
sehingga memungkinkan kolaborasi.

'Website : http://www.alfresco.com/

)

%,

WordPress ialah platform penerbitan pribadi yang
semantik, yang berfokus pada estetika, standar web, dan
kegunaan. WordPress bersifat gratis, namun di sisi lain juga
tak ternilai harganya. Pendek kata, WordPress ‘lah yang
Anda perlukan ketika ingin membangun sebuah blog atau
sebuah situs web yang cantik.

Piranti lunak inti WordPress dikembangkan oleh ratusan
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sukarelawan. Ketika Anda ingin dapatkan lebih banyak
kegunaan daripadanya, ada ribuan plugin dan tema yang
tersedia untuk mengubah situs Anda menjadi nyaris apa
saja yang Anda dambakan. Lebih dari 25 juta orang
memilih WordPress sebagai “rumah”nya di jaringan
internet — dan tentunya kami juga ingin agar Anda juga
dapat bergabung dengan kami dan mereka semuanya.
Website : https://wordpress.org/

Network Monitoring System

~ |Website : http://www.cacti.net/

Cacti adalah aplikasi frontend dari RRDTool yang
menyimpan informasi kedalam database MySQL dan
membuat grafik berdasarkan informasi tersebut. Proses
pengambilan data (lewat SNMP maupun skrip) sampai
kepada pembuatan grafik dilakukan menggunakan bahasa
pemrograman PHP. Secara sekilas, cacti mempunyai
tampilan grafik yang sama dengan MTRG, namun cacti
mempunyai banyak kelebihan dibandingkan dengan
MRTG seperti adanya template untuk grafik, zoom grafik
dan lain sebagainya.
Cacti dapat digunakan untuk menyimpan graph, data
sources, dan round robin archives ke dalam sebuah|
database. Aplikasi ini juga mendukung protocol SNMP)
sehingga dapat digunakan untuk membuat traffic graph
menggunakan MRTG.

J|nagios sesuai dengan kebutuhan Anda. Untuk
‘||lmendownload ~ source  nagios  klik url inj

-/|Nagios awalnya didesain untuk berjalan pada sistem
"loperasi Linux, namun dapat juga berjalan dengan baik

[Nagios adalah tool network monitoring system open sourcg
yang terbaik. Nagios bersifat modular, mudah digunakan,
dan memiliki skalablitas tinggi|
Modul atau plugin pada nagios sangat simple Anda pun
dapat membuatnya guna melengkapi system checking pada

http://www.nagios.org/download/

hampir disemua sistem operasi unix like.
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'Webiste : http://www.nagios.org/

Desain Grafis (Graphic Design)

GNU Image Manipulation Program atau yang lebih dikenal
dengan sebutan GIMP adalah perangkat lunak untuk
manipulasi grafik berbasis raster. GIMP berjalan pada
desktop GNOME dan dirilis dengan lisensi GNU General
Public License. GIMP pada awalnya dikembangkan untuk
desktop X11 yang berjalan di platform Unix.

Namun saat ini piranti lunak ini sudah diporting ke
beberapa platform sistem operasi yang lain yaitu MS
'Windows dan Mac OS. Grafik yang dihasilkan oleh GIMP
disimpan dengan format XCF dan bisa diekspor kg
berbagai format gambar seperti bmp, jpg, gif, pdf, png, svg,
tiff, dan masih banyak lagi yang lainnya.

GIMP  menyediakan banyak sekali plugin yang
memudahkan dalam mengolah gambar (image) dengan
cepat. Pengembang dan pengelola GIMP memiliki visi
produk GIMP untuk berusaha menjadi perangkat lunak
grafis kelas atas dalam menyunting dan menciptakan
gambar asli, foto, ikon, elemen grafis halaman web, dan
seni untuk elemen antarmuka pengguna.

Website : http://www.gimp.org/

INKSCAPE

Inkscape adalah sebuah perangkat lunak editor gambar
vektor yang bersifat perangkat lunak bebas dibawah lisensi
GNU GPL. Tujuan utama dari Inkscape adalah menjadji
perangkat grafik mutakhir yang memenuhi standar XML,
SVG, dan CSS.

Inkscape bersifat cross-platform dan dapat dijalankan pada
Mac OS X (biasanya dibawah aplikasi X11, walaupun
toolkit GTK+ yang digunakan dapat dikompilasikan untuk
beroperasi secara langsung dibawah Quartz), sistem operasi
berbasis Unix, dan Microsoft Windows. Implementasi
SVG dan CSS di Inkscape belum sempurna, misalnya|
Inkscape tidak mendukung animasi SVG, dan font SVG,

walaupun dukungan dasar untuk pembuatan font SVG telah
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diimplementasikan pada versi 0.47. Inkscape bersifaf
multibahasa, terutama untuk antarmuka dan script rumit,
sesuatu yang sering terlewatkan pada sebagian besar editor]
grafik vektor komersil.

'Website: http://inkscape.org/

Lainnya

A

penLDAP’

OpenLDAP merupakan salah satu software yang
menerapkan protokol LDAP (Light Weight Directory
[Access Protocol) yang bersifat OpenSource dan tersedia
diseluruh sistem operasi Linux. OpenLDAP memiliki
bentuk struktur yang berhirarki (sistem pohon seperti pada
file sistem linux), bukannya berformat kolom dan baris,)
seperti halnya database normal, sehingga memudahkan
untuk memasukkan sejumlah besar detail yang mirip dalam
bentuk yang terorganisir.

Di dalam OpenLDAP terdapat 2 service utama yaitu : slapd
dan slurp. Slapd merupakan OpenLDAP daemon yang
melayani permintaan dari klien, query dan berkomunikasi
dengan backend database. Sedangkan slurp merupakan
replication daemon yang berfungsi melayani replikasi data
agar terus terjadi sinkronisasi data antara klien dan server.
Dengan penggunaan OpenL.DAP dalam suatu sistem, maka
akan memudahkan sistem tersebut dalam melakukan
manajemen pengguna, karena data pengguna terpusat pada
satu sistem. Atau istilah kerennya yaitu Single Sign On.

‘Website : http://www.openldap.org/

Project Management

@ git

Git adalah perangkat lunak pengontrol versi atau proyek
manajemen kode perangkat lunak yang diciptakan oleh
Linus Torvalds, yang pada awalnya ditujukan untuk
pengembangan kemnel Linux. Desain Git terinspirasi oleh
BitKeeper dan Monotone. Git pada awalnya hanya

dirancang sebagai mesin tingkat rendah yang dapaf
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digunakan oleh tampilan muka (front end) lain seperti
Cogito atau StGIT. Namun selanjutnya proyek inti Git telah
berkembang menjadi pengontrol revisi lengkap yang dapat
digunakan langsung. Saat ini, beberapa perangkat lunak
terkenal menggunakan Git sebagai pengontrol revisinya,
antara lain kernel Linux, Server X.org, pengembangan inti
OLPC (One Laptop per Child), serta kerangka kerja web
Ruby on Rails.

‘Webiste : http://git—scm.com/

0]
ﬁ collabtive

Collabtive adalah perangkat lunak manajemen proyek
berbasis web yang diterbitkan sebagai perangkat lunak
bebas (open source). Collabtive merupakan aplikasi open
source alternatif disamping aplikasi berbayar yang sama
seperti Basecamp.

'Website : http://collabtive.o-dvn.de/

Proxy Management

Lightsquid merupakan proxy squid analizer yang berbasis
web, atau lebih tepatnya tools yang digunakan untuk
menganalisa log dari user yang menggunakan squid kita
yang datanya diambil oleh lightsquid dari squid
(access.log), instalasi dari lightsquid ini juga relatif mudah
dengan fitur2 yang menarik.

‘Website : http://lightsquid.sourceforge.net/

Squid adalah sebuah daemon yang digunakan sebagai
proxy server dan web cache. Squid memiliki banyak jenis
penggunaan, mulai dari mempercepat server web dengan
melakukan caching permintaan yang berulang-ulang,
caching DNS, caching situs web, dan caching pencarian
komputer di dalam jaringan untuk sekelompok komputer
yang menggunakan sumber daya jaringan yang sama,
hingga pada membantu keamanan dengan cara melakukan
penyaringan (filter) lalu lintas. Meskipun seringnya
digunakan untuk protokol HTTP dan FTP, Squid jugd

menawarkan dukungan terbatas untuk beberapa protokol
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lainnya termasuk Transport Layer Security (TLS), Secure)
Socket Layer (SSL), Internet Gopher, dan HTTPS. Versi|
Squid 3.1 mencakup dukungan protokol IPv6 dan Internef
Content Adaptation Protocol (ICAP).

Squid umumnya didesain untuk berjalan di atas sistem)
operasi mirip UNIX, meski Squid juga bisa berjalan di atas
sistem operasi Windows. Karena dirilis di bawah lisensi|
GNU General Public License, maka Squid merupakan
perangkat lunak bebas.

Website : http://www.squid—cache.org[
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Postfix adalah mail transfer agent bebas dan terbuka)
Postfix merupakan mail transfer agent default untuk
sejumlah  sistem operasi bertipe Unix. Postfix]
didistribusikan menggunakan Lisensi Umum IBM 1.0 yang
merupakan lisensi perangkat lunak bebas tetapi tidak
kompatibel dengan GPL. Postfix dulu bernama VMaile
dan IBM Secure Mailer.

Postfix pada awalnya dibuat oleh Wietse Venema sewaktu
ia bekerja di IBM Thomas J. Watson Research Center, dan
sampai sekarang masih aktif dikembangkan. Postfix
pertama kali dirilis pada pertengahan 1999. Postfix
mempunyai milis yang aktif sekali, dan Wietse Venema
sangat aktif membantu anggota yang bertanya disana.

Salah satu ketangguhan Postfix adalah kemampuannysa
menahan "buffer overflow". Ketangguhan lainnya adalah
kesanggupan Postfix memproses surat elektronik dalam
jumlah banyak. Postfix dibuat dengan sistem jaringan|
daemon di mana setiap daemon hanya mengerjakan satu
tugas dengan menggunakan akses minimum ke sistem,
Dengan begitu, jika ada satu daemon yang bermasalah
maka hanya akan memengaruhi daemon tersebut dan tidak
akan berimbas ke seluruh sistem Postfix. Sewaktu Postfix
dijalankan, hanya ada satu proses yang menggunakan akses
"I'OO "‘

‘Website: http://www.postﬁx.org[
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g;_‘ SquirrelMail

SquirrelMail adalah email klien berbasis web, atau aplikasi|
webmail, yang ditulis dalam PHP dengan penekanan pada
standar web dan kompatibilitas luas di seluruh web
browser. Halaman output oleh SquirrelMail yang
kompatibel dengan HTMLA.0 dan tidak menggunakan
script sisi klien|

SquirrelMail mendukung IMAP untuk mengambil dan|
SMTP untuk mengirim email. Ekstensi atau plug-in ini juga|
tersedia untuk menambahkan fungsionalitas ke instalasi
dasar SquirrelMail.

‘Website : http://squirrelmail.org/

roundcube &g

RoundCube adalah webmail berbasis IMAP yang ditulis
dalam bahasa pemrograman PHP. Fitur andalan
RoundCube adalah penggunaan teknologi Ajax untuk
menyajikan lebih informasi email secara lebih responsif
daripada webmail lainnya tradisional.

'Website : http://roundcube.net/

|Cloud Storage

J|berbagi bagi pengguna. ownCloud memberikan akses

OwnCloud merupakan suatu perusahaan dengan proyeknya
yaitu ownCloud project. Slogan perusahaan ini adalah Your
Cloud, Your Data, Your Way!. ownCloud yang merupakan
salah satu perangkat lunak berbagi berkas gratis dan bebasg
seperti Dropbox, menyediakan pengamanan yang baik]
memiliki tata cara yang baik bagi pengguna aplikasi untuk
membagi dan mengakses data yang secara lancar
terintegrasi dengan perangkat teknologi informasi yang
tujuannya mengamankan, melacak, dan melaporkan
penggunaan data.

ownCloud menempatkan kontrol kepada penggunad
teknologi informasi itu sendiri dan juga menawarkan
penyedia layanan, pusat dan bagian transmisi yang
berfungsi untuk menyediakan solusi sinkronisasi dan

terhadap  berkas-berkas  secara  universal dengan
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menggunakan antarmuka jaringan atau WebDAV.

'Website : http://owncloud.org/

Virtualisasi / Cloud Computing

oVirt

oVirt sendiri dibangun berdasarkan proyek KVM (kernel-
based vitual machine). KVM sendiri sudah menjadi bagian
dalam kernel Linux sejak tahun 2006. Kelebihan dari oVirt
ini terletak pada kecilnya ukuran software ini, selain itu,|
oVirt menawarkan platform manajemen virtualisasi
berbasis web.

'Webiste : http://www.ovirt.org/Home

2KVM

Kernel-based Virtual Machine (KVM) merupakan
infrastruktur virtual dari Kernel Linux. KVM mendukung]
native virtualization pada x86 processor yang menyediakan
Intel VT-x atau AMD-V extensions. Selain itu, porting
untuk S/390, PowerPC, [A-64, dan ARM juga sedang
dilakukan.

Kernel Linux 2.6.20, merupakan rilis kernel pertama yang
menyertakan ~ dukungan KVM. pada  awalnya,
pengembangan KVM dimulai oleh perusahaan bernama
Qumranet. Pada tahun 2008, Red Hat mengakuisi
Qumranet, sehingga KVM secara otomatis kini dimilikij
oleh Red Hat.

'Website : http://www.linux-kvin.org/page/Main_Page

IDNS (Domain Name System)

Bind9 (Berkeley Internet Name Domain versi 9) adalah
salah satu aplikasi linux yang sangat populer sebagai DNS
Server, dan hampir disemua distro linux menggunakanya.
Selain itu, dalam konfigurasinya pun cukup mudah untuk]
dimengerti, khususnya bagi kita yang masih pemula.

‘Website : https://www.isc.org/downloads/bind/

Server
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Red5 merupakan suatu aplikasi Media Server berbasis Java
yang gratis, open source aplikasi Java Flash Media Server
yang didasarkan pada reverse engineering dari protokol

ed @ RTMP dan AMF. Mendukung streaming dan rekaman
r audio / video, live streaming, dan Flash Remoting.

server |website : http:/www.redS.org/

4.3 Kategori Software/Perangkat Lunak

Dengan mengenal bermacam perangkat lunak, maka anda bisa memahami
beragam produk dan fungsinya. Ada banyak contoh dari software yang
lazimnya digunakan oleh masyarakat. Berikut ini beberapa kategori dan
contohnya.

1. Software Sistem Operasi

Terdapat sejumlah perangkat lunak yang digunakan sebagai sistem operasi
komputer. Contohnya adalah :

e Linux,

e Mac,

e  Windows.

Sistem operasi Windows lebih banyak digunakan karena harganya lebih
murah daripada Mac. Wajar saja kalau pengguna Windows relatif lebih
banyak ketimbang Mac dan Linux. Meskipun Linux tidak berbayar karena
bersifat open source, tapi tetap kalah jumlah penggunanya dari Windows.
Sebab Windows lebih mudah dalam cara pengoperasiannya.

2. Software Browser

Ketika anda ingin mencari informasi tertentu, biasanya akan melakukannya
dengan bantuan situs pencari. Beberapa contoh perangkat lunaknya adalah:

e Opera Mini,

e Internet Explorer,

e Mozilla Firefox,

e Chrome dan sebagainya.

Dari segi banyaknya pengguna, Chrome menempati posisi tertinggi. Sebab
tampilannya lebih rapi, sehingga lebih nyaman dan menyenangkan saat
digunakan.



62 Aplikasi Komputer

3. Microsoft Office

Sesuai namanya perangkat lunak ini memang memiliki fungsi sebagai
penunjang urusan perkantoran. Seperti pengetikan dokumen, akuntansi, media
presentasi dan sebagainya. Sejumlah contoh dari software ini adalah :

e  Microsoft Word, Excel,

e Powerpoint,

e  Qutlook,

e Publisher dan sebagainya.
4. Paint Software

Perangkat lunak ini berfungsi sebagai pengolah gambar atau desain. Sehingga
anda bisa membuat gambar atau pola tertentu, melakukan editing dan
sebagainya. Beberapa contoh softwarenya adalah :

e Corel Draw,

e Adobe Photosoft,

¢ Paint dan sebagainya.

5. Software Anti Virus

Serangan virus bisa menimpa setiap komputer, khususnya yang sering
berselanjar di dunia maya, kerap mengunduh file dan sebagainya. Untuk itu,

komputer membutuhkan sistem perlindungan agar tidak mudah terserang
virus. Sebagai contoh adalah :

e AVG,
e Norton,
e Avast,

¢ Smadav dan sebagainya.

Nabh, itulah beberapa informasi penting seputar perangkat lunak atau software
untuk komputer. Pengembangan selalu terjadi pada spesifikasi, fitur dan
fungsinya. Hal ini tentunya bertujuan untuk semakin memudahkan para
pengguna komputer. Karena itu, pastikan anda selalu menggunakan versi
terbarunya.

6. Software Multimedia

Software Multimedia adalah software yang digunakan untuk mengolah
beberapa media informasi, seperti teks, image/gambar, audio, grafik, video,
dan interaktif. Software Multimedia tersebut dapat didapat dari yang berlisensi
sampai yang Open Source.
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Berikut ini ada jenis-jenis software multimedia yang diketahui :

a. Audio/Video Editor

Video/audio editor adalah jenis perangkat lunak yang digunakan untuk
mengedit dan memanipulasi informasi dalam bentuk video dan audio. Banyak
sekali proses dalam mengedit video dan audio, contohnya adalah proses
pemotongan, penggabungan, konversi format audio/video, dan manipulasi
kualitas audio/video. Beberapa jenis perangkat lunak media player adalah:

1. Adobe Premiere Pro, bersifat komersial dan diproduksi oleh Adobe

Systems.

2. Adobe Premiere Elements, bersifat komersial dan diproduksi oleh
Adobe Systems.

3. Windows Movie Maker, bersifat komersial dan diproduksi Microsoft
Corp.

4. Pinnacle Studio, bersifat komersial dan diproduksi oleh Pinnacle
Systems.

5. TMPGEnc, bersifat komersial dan diproduksi oleh Pegasis Inc.

b. Graphic/Image Editor.

Image editor adalah perangkat lunak yang digunakan untuk melukis,
menggambar, mengedit dan memanipulasi image atau gambar secara interaktif
pada sistem komputer. Banyak sekali jenis perangkat lunak image editor mulai
dari dengan fungsi editing yang sederhana sampai dengan yang kompleks.
Terdapat dua jenis image yang dihasilkan oleh image editor, yaitu dalam
bentuk bitmap image dan vector image. Beberapa contoh perangkat lunak
image editor adalah sebagai berikut:

1. Adobe Photoshop, merupakan vector dan bitmap image editor.

Bersifat komersial dan diproduksi oleh Adobe Systems.

2. Corel Draw, merupakan vector image editor. Bersifat komersial dan
diproduksi oleh Corel Corporation.

3. Microsoft Paint, merupakan bitmap image editor. Bersifat komersial
dan masuk dalam paket Microsoft Windows.

4. Paint Shop Pro, merupakan vector dan bitmap image editor. Bersifat
komersial dan diproduksi oleh Corel Corporation.

5. GIMP, merupakan bitmap dan vector image editor. Bersifat open
source dan diproduksi oleh The GIMP Team dengan lisensi GNU
General Public License.
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c. Grafik 3D.

Aplikasi grafik 3 dimensi (3D) adalah perangkat lunak yang digunakan untuk

membuat, mengedit, dan memanipulasi informasi dalam bentuk gambar 3

dimensi. Berbeda dengan format gambar atau image secara umum adalah

dalam bentuk 2 dimensi. Gambar 3 dimensi merupakan representasi gambar
dalam geometri 3 dimensi. Beberapa contoh perangkat lunak grafik 3D adalah
sebagai berikut:

1. 3D Studio Max, bersifat komersial dan diproduksi oleh Autodesk
Media & Entertainment.

2. Silo 3D Modelling, bersifat komersial dan diproduksi oleh
Nevercenter Ltd. Co.

3. Maya, bersifat komersial dan diproduksi oleh Alias Systems Corp

d. Animasi.

Aplikasi animasi adalah perangkat lunak yang digunakan untuk membuat,

mengedit, dan memanipulasi informasi dalam bentuk animasi. Animasi adalah

gambar bergerak atau video dengan konten gambar yang fiktif, seperti kartun
dan gambar tidak riil. Beberapa contoh perangkat lunak animasi adalah
sebagai berikut:

1. Macromedia Flash, merupakan perangkat lunak animasi yang banyak
digunakan, baik untuk web, presentasi, dll. Bersifat komersial dan
diproduksi oleh Macromedia Inc.

2. Houdini Animation Software, bersifat komersial dan diproduksi oleh
Side Effect Software.

3. Power Animator, merupakan generasi pendahulu dari Maya untuk
membuat animasi. Bersifat komersial dan diproduksi oleh Alias
Systems Corporation.

e. Graphis/Image Viewer.

Image viewer adalah jenis perangkat lunak yang digunakan untuk melihat
(view) image secara terorganisasi pada sebuah direktori. Saat ini sudah banyak
sekali format image yang telah didukung oleh aplikasi image viewer, seperti
bmp (windows bitmap), jpeg/jpg (image terkompresi), gif (CompuServe), png
(portable network graphics), ico (icons image), dll. Biasanya perangkat lunak
ini juga menyediakan fasilitas untuk mengedit image dalam fungsi-fungsi yang
sederhana.
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Beberapa jenis perangkat lunak image viewer adalah:

L.

2.
3.
4

f.

ACDSee, bersifat komersial dan diproduksi oleh ACD System:s.
XNView, bersifat freeware dan diproduksi oleh Pierre-e Gougelet.
Irfan View, bersifat komersial dan diproduksi oleh Irfan Skiljan.
Microsoft Picture Manager, bersifat komersial dan diproduksi oleh
Microsoft Corp.

Microsoft Picture and Fax Viewr, bersifat komersial dan masuk
dalam paket Microsoft Windows.

Media Player.

Media player adalah jenis perangkat lunak yang digunakan untuk memainkan
informasi dalam bentuk audio dan video. Biasanya aplikasi media player saat
ini sudah bisa untuk memainkan baik informasi audio maupun video.
Beberapa jenis perangkat lunak media player adalah:

L.

7.

Windows Media Player, bersifat komersial dan diproduksi oleh
Microsoft Corp. Perangkat lunak ini ikut dalam paket Microsoft
Windows.

Winamp, bersifat freeware/komersial dan diproduksi oleh Nullsoft
Inc..

WinDVD, bersifat komersial dan diproduksi oleh Intervideo.
PowerDVD, bersifat komersial dan diproduksi oleh Cyberlink.
Musicmatch Jukebox, bersifat komersial dan diproduksi oleh
Musicmatch Inc.

DivX Player, bersifat freeware atau komersial, diproduksi oleh
DivXNetwork Inc.

Real Player, bersifat komersial dan diproduksi oleh Real Networks.
XMMS, audio player bersifat open source dan dibawah lisensi GNU
General Public License.

Xine, DVD player yang bersifat open source dan dibawah lisensi
GNU General Public License

PDF Viewer.

PDF Viewer adalah adalah jenis perangkat lunak yang digunakan untuk
membuka file pdf. Beberapa jenis perangkat PDF Viewer adalah :

1.
2.

Adobe Reader
Foxit Reader
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8. Pemrograman/Coding

Aplikasi coding/pemrograman yang dibutuhkan para programmer untuk
menciptakan aplikasi umumnya berisi barisan kode. Semakin lengkap barisan
kode tersebut, maka aplikasi yang dihasilkan pun semakin maksimal. Dengan
aplikasi coding, programmer bisa menyusun barisan kode tersebut hingga
membentuk aplikasi baru. Beragam aplikasi coding pun hadir dengan
spesifikasi yang berbeda-beda. Ada yang memiliki fitur sederhana, ada pula
yang punya fitur lengkap, bahkan ada juga yang menyediakan bermacam
plugin tambahan. Programmer biasanya memilih aplikasi coding yang
mengusung bahasa pemrograman yang sesuai dan lengkap.

Tetapi, yang terpenting adalah, aplikasi tersebut harus sesuai dengan sistem
operasi PC yang mereka gunakan. Terlebih, jika aplikasi coding itu cukup
ringan, kompatibel (mampu digunakan pada segala sistem operasi) dan dapat
terintegrasi dengan program lain, pasti disukai banget oleh para programmer.
Berikut adalah deretan aplikasi coding di PC yang dapat Anda gunakan

e Sublime Text
e Visual Code Studio

e Emacs

e Komodo Edit
e Atom

e BluceFish

e Brackets

e UltraEdit

e Vim

e Android Studio
e Eclipse
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Microsoft Word

5.1 Pengertian Microsoft Word

Microsoft Word merupakan aplikasi sebuah program pengolah kata (word
processor) yang dibuat oleh Microsoft Corporation. Program ini biasanya
digunakan para pemakai komputer untuk kegiatan tulis-menulis. Seperti
pembuatan surat, proposal, artikel, brosur, booklet, dan lain-lain dengan aneka
font (huruf) dan layout yang tersedia. Kita juga dapat membuat naskah ilmiah
dengan rumus-rumus matematika, fisika maupun kimia dan mendesain sebuah
dokumen dengan variasi gambar yang unik dan sangat lengkap.

Selain, Microsoft Word, ada beberapa jenis word processor yang popular dan
sudah beredar di masyarakat di antaranya : WordStar (WS), WordPerfect
(WP), AmiPro, WordPad, dan lain-lain. Microsoft Word sebagai program
pengolah kata memberikan fasilitas-fasilitas yang lebih familiar dibandingkan
dengan pengolah kata lainnya. Program pengolah kata Microsoft Word telah
mengeluarkan versi 1.0. sampai 6.0. untuk versi DOS. Kemudian, seiring
dengan kemajuan perusahaan pembuatnyya, Microsoft Coorporation telah
mengeluarkan 12 versi Microsoft Word, yaitu versi 95, 97, 2000, 2002, 2003,
2007dan Timeline Version Office (2007.ver VS 2010.ver) Pengertian
Microsoft Word 2010 adalah program pengolah kata non-bebas komersial
yang dirancang oleh Microsoft. Ini pertama kali dirilis pada tahun 1983 dengan
nama Multi-Tool Word untuk sistem Xenix. versi berikutnya kemudian ditulis
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untuk beberapa platform termasuk PC IBM menjalankan DOS (1983), Apple
Macintosh (1984), AT & T Unix PC (1985), Atari ST (1986), SCO UNIX, OS
/2, dan Microsoft Windows (1989). Ini adalah komponen dari sistem Microsoft
Office, melainkan juga dijual sebagai produk mandiri dan termasuk dalam
Microsoft Works Suite. Versi saat ini adalah Microsoft Word 2010 untuk
Windows dan 2011 untuk Mac. Asli format file Microsoft Word diti baik oleh
doc. atau. docx ekstensi file. (Andikaputra, 2018)

Microsoft Office adalah sebuah program aplikasi perkantoran yang dibuat oleh
Microsoft untuk menunjang berbagai kegiatan perkantoran. Microsoft Office
dirancang untuk dijalankan dibawah sistem operasi Microsoft Windows dan
Mac OS X.

5.2 Membuat dan Membuka Dokumen

Membuat dokumen baru merupakan langkah paling dasar yang harus
diketahui ketika menggunakan Microsoft Word. Begitu juga dengan membuka
dokumen, ini akan penting ketika kita hendak mengedit dokumen yang
sebelumnya pernah dibuat. (Charis, 2021)

5.2.1 Membuat Dokumen

Pada Microsoft Word terbaru, akan disuguhkan tampilan dengan berbagai
template ketika pertama membukanya. Pada menu tersebut, bisa memilih
Blank document untuk membuat dokumen baru.Jika sudah masuk ke halaman
Microsoft Word dan ingin membuat dokumen baru, maka bisa memilih menu
File > New > Blank document. Untuk Ms Word 2019, mungkin tidak akan
ditemukan menu File, karena menu tersebut diti dengan Icon Ms Word (pojok
kiri atas).

3].

c=0e .«

Gambar 5.1: Membuat Dokumen Baru
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Pada langkah ini saya menggunakan Ms Word 2019. Dari segi tampilan
memang sedikit berbeda, namun tetap sama saja . Pada Microsoft Word 2007,
akan langsung bisa membuat dokumen ketika membuka aplikasinya tanpa
harus memilih Blank document.

5.2.2 Membuka Dokumen

Untuk membuka dokumen Microsoft Word, berarti sudah harus berada dalam
aplikasi. Langkahnya sangat mudah, tinggal memilih menu File > Open >
Browse lalu cari file yang ingin dibuka.

Gambar 5.2: Membuka Dokumen

Hal ini berlaku pada semua versi Microsoft Word. Mungkin yang
membedakan adalah kalau versi Microsoft Word 2007, tidak ada menu
Browse jadi kita tinggal menekan Icon Ms Word (pojok kiri atas) > Open >
lalu cari dokumen yang akan dibuka.

5.3 Menyimpan Dokumen

Menyimpan dokumen dilakukan setelah kita membuat ataupun mengedit
dokumen. Menyimpan dokumen terbagi menjadi 2 yaitu Save dan Save As.
Silahkan simak penjelasan di bawah ini agar lebih jelas.

5.3.1 Save (Menyimpan Dokumen Baru)

Save merupakan menu yang digunakan untuk menyimpan dokumen baru.
Jadi, ketika kita membuat dokumen baru (melalui blank document) di
Microsoft Word, kita menggunakan Save untuk menyimpannya. Untuk cara
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menyimpan dokumen dengan Save, tinggal memilih menu File > Save > lalu
cari tempat untuk menyimpannya. Selain itu, juga bisa menekan tombol Icon
Save (lihat gambar di bawah ini). Atau opsi paling mudahnya dengan menakan
tombol Ctrl+S.

Gambar 5.3: Save

5.3.2 Save As (Menyimpan Dokumen Lama dengan Nama
Baru)

Save As digunakan untuk menyimpan dokumen lama dengan nama baru. Jadi,
ketika mengedit dokumen milik teman dan ingin dijadikan dokumen milik
sendiri, maka bisa menggunakan Save As untuk menyimpannya.

Untuk cara menyimpan dokumen lama dengan nama baru, bisa memilih menu
File > Save As > Browse > lalu pilih tempat untuk menyimpan file tersebut.

Gambar 5.4: Save As
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5.4 Mengubah Jenis Font

Mengubah jenis font dilakukan untuk menyesuaikan pengaturan yang
ditentukan. Karena biasanya, setiap membuat dokumen (khususnya tugas)
dengan Microsoft Word, ada ketentuan jenis font dan ukurannya.

Selain itu, cara ini juga harus dilakukan ketika hendak menulis bahasa Arab,
karena ada pengaturan tersendiri agar hasilnya rapi Untuk mengubah font pada
Ms Word, masuk ke menu Home > lalu klik pada bagian fotn dan ganti font
sesuai kebutuhan.

Gambar 5.5: Font

Penting: Jika sebelumnya sudah menuliskan kata dan ingin mengubah font,
maka terlebih dahulu harus memblock semua tulisan dengan menekan Ctrl+A.
Karena jika tidak, maka tidak akan ada perubahan font. Untuk mengubah
ukuran font, bisa mengaturnya melalui angka yang ada di sebelah kanan kolom
font. Silahkan ubah ukuran sesuai kebutuhan.

5.5 Mengatur Margin

Semua versi Microsoft Word memiliki cara yang sama untuk mengatur
margin, baik dari segi menu maupun tampilan. Margin dibedakan menjadi 4
yaitu margin atas, margin bawah, margin kanan, dan margin kiri.

Sebagai contoh, saya ingin mengatur margin dengan ukuran atas 3cm, bawah
3cm, kanan 3cm, dan kiri 4cm. Silahkan simak langkahnya di bawah ini.

1. Silahkan pilih menu Layout/Page Layout > Margin > Custom
Margin.
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5.5‘Mengatur-Marginy|

kA
e klik Ok

Gambar 5.6: Merubah Margin
2. Setelah itu, ubah margin sesuai kebutuhan. Contohnya top 3cm,

bottom 3cm, right 3cm, dan left 4cm.
e

Gamba;' 5.7 7 Ukuran Margin
3. Jika sudah, silahkan klik Ok.

Kedua cara ini intinya sama, yaitu membuka menu Page Setup. Silahkan
gunakan cara yang paling mudah dan cepat menurut Pengaturan margin ini
juga sangat berpengaruh ketika mencetak label undangan. Untuk menambah
referensi terkait hal ini, silahkan baca cara membuat label undangan otomatis.

5.6 Mengatur Jarak Spasi

Jarak spasi pada Microsoft Word terbagi menjadi 3 yaitu spasi antar karakter,
spasi antar kata, dan spasi antar baris kalimat (dalam paragraf). Untuk lebih
jelasnya, silahkan simak penjelasan di bawah ini.
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5.6.1 Mengatur Spasi Antar Karakter

Spasi antar karakter adalah jarak antar huruf dalam satu kata. Jika sudah
menuliskan kata, silahkan tekan Ctrl+A terlebih dahulu.

1. Pertama, pilih menu Home > lalu pilih icon peluncur Font seperti
gambar di bawah ini. Alternatifnya, silahkan tekan tombol Ctrl+D
pada keyboard.

1. + Pertama, pity menu Home:> bahu: pilih- icon peluncur- Fout: seperti
gambar ds bawah- me Alicostifinya,- siluhken: tekas: tombol- Ciel+1)
pas keyboard, 4

2. - Kemdian, ‘pindah ke tab Advanced. Pada: bagian-Spacing. silahkan
al- kebutuhan, - Jik i
Sedangkan- jika: mesmil

3. JLashLlh Klik Ok g

Gambar 5.8: Spas1 antar karakter
2. Kemudian, pindah ke tab Advanced. Pada bagian Spacing, silahkan
ubah sesuai kebutuhan. Jika memilih Expanded, maka spasi akan
diperluas. Sedangkan jika memilih Condensed, maka spasi akan
dirapatkan.

A AACE AT (A1

oo

.
-
2. - Kemudian, pir " \*Spacing.-silahkan

ubah- sesuai
diperluas. Sed
dirapatkan, §

3. - Jika-sudah, khkux

Sb. Mengatur Spasi-Antar-Kata®
Srast -antar-kata-adalah ek antar-kata-dalam-kalimas,Tika-sudah-menuliskan

= "eRE0 FEe T dean i w

Gambar 5.9: Ukuran Spasi Karakter
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3. Jika sudah, klik Ok.

5.6.2 Mengatur Spasi Antar Kata

Spasi antar kata adalah jarak antar kata dalam kalimat. Jika sudah menuliskan

kata, silahkan tekan Ctrl+A terlebih dahulu.

1. Pertama, pilih menu Home > lalu pilih icon peluncur Font seperti
gambar di bawah ini. Alternatifnya, silahkan tekan tombol Ctrl+D
pada keyboard.

- €o

Gambar 5.10: Me;lgatur spasi antar kata
2. Setelah itu, pilih tab Advanced. Pada bagian Scale silahkan ubah
sesuai kebutuhan.

Gambar 5.171: Ulgﬁran spasi antar kata
3. Semakin besar nilainya, maka akan semakin renggang jaraknya.
4. Klik Ok untuk menyimpannya.

5.6.3 Mengatur Spasi Antar Baris Kalimat (dalam paragraf)

Untuk langkah ini digunakan untuk mengatur jarak antar baris dalam satu
paragraf. Jika sudah menuliskan kata, silahkan tekan Ctrl+A terlebih dahulu.
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1. Pertama, pilih Home > lalu pilih icon peluncur Paragraph seperti
gambar di bawabh ini.

Gambar 5.12: Spﬁsi Antar Paragraph
2. Lalu, pada bagian Line Spacing silahkan ubah sesuai kebutuhan.
3. Jika sudah, klik OK untuk menyimpan pengaturan.

5.7 Mengubah Ukuran Kertas

Mengatur ukuran kertas digunakan ketika hendak mencetak dokumen. Dengan
mengatur ukuran kertas, maka tampilan dokumen dan hasil ketika dicetak akan
sama. Karena jika pengaturan di Ms Word menggunakan kertas A4,
sedangkan kertas print adalah A3, maka kertas A3 tidak akan penuh. Untuk
mengubah ukurannya, silahkan pilih menu Layout > Size dan pilih ukuran
yang dibutuhkan.

Gambar 5.13: Meruabah Ukuran Kertas

Penting: Tidak semua ukuran kertas tertera pada menu size. Untuk mengubah
sesuai keinginan Kkita, silahkan pilih Margin>custome margin>Paper Sizes dan
masukkan ukuran yang dikehendaki pada kolom Width (lebar) dan Height
(tinggi).
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g e e =xr|

A e

Gambar 5.14: Custum Margin

Terdapat 2 macam orientasi kertas pada Microsoft Word yaitu Potrait dan
Landscape. Potrait adalah tampilan kertas dengan posisi berdiri, sedangkan
landscape adalah tampilan kertas dengan posisi persegi panjang.

5.8 Membuat Tabel Sederhana

Tabel pada Microsoft Word digunakan untuk mengatur jenis konten. Tabel
banyak digunakan pada dokumen dengan tampilan data numerik sehingga
mudah dipahami. Tabel pada Ms Word bisa diubah menjadi keren, Untuk
membuat tabel sederhana, silahkan pilih menu Insert > Table > lalu pilih
jumlah kolom yang diinginkan.

» - 7 .
ncscspe adaiah tumpeban kertus dengn posis: parve purgan Y

i.8:-Membuat-Tabel-Sederhanaf
ads Mscros k-meng

abel

Untuk-mesgamir-jumiah-baris-dan-kolom sesuai keinginan, silshken piih Insert-
Table yang-saya-ti b rasubdanjumish yang dkebemdaki §

Mezambalikan Ganter pada Dokumen®

Gambar 5.15: Membuat Tabel Sederhana

Untuk mengatur jumlah baris dan kolom sesuai keinginan, silahkan pilih Insert
Tabel lalu masukkan jumlah yang dikehendaki.
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Microsoft Excel

6.1 Pengertian Microsoft Excel

Pengertian Microsoft Excel adalah sebuah program atau aplikasi yang
merupakan bagian dari paket instalasi Microsoft Office, berfungsi untuk
mengolah angka menggunakan spreadsheet yang terdiri dari baris dan kolom
untuk mengeksekusi perintah. Microsoft Excel telah menjadi software
pengolah data / angka terbaik di dunia, selain itu Microsoft Excel telah
didistribusikan secara multi-platform. Microsoft Excel tidak hanya tersedia
dalam platform Windows, Microsoft Excel juga tersedia di MacOS, Android
dan Apple (Advernesia, 2020).

Microsoft Excel secara fundamental menggunakan spreadsheet untuk
manajemen data serta melakukan fungsi-fungsi Excel yang lebih dikenal
dengan formula Excel. Excel merupakan program spreadsheet elektronik.
Spreadsheet adalah kumpulan dari Sel yang terdiri atas baris dan kolom tempat
anda memasukkan angka pada Microsoft Excel. Jumlah Sel Microsoft Excel
2016 terdiri dari 1.048.576 Baris dan 16.384 Kolom atau 17.179.869.184 Sel.
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e-29 000 CRL— |

Gambar 6.1: Tampilan Excel

Sebagai program pengolah angka terpopuler, Microsoft Excel mempunyai
banyak kelebihan dan beberapa kekurangan untuk penggunaan tertentu.

6.1.1 Kelebihan Microsoft Excel

1.

® Nk wd

10.
11.
12.

User interface yang mudah untuk dipahami.

Kompatibilitas dengan berbagai platform/sistem operasi.

Mudah dipelajari untuk pengguna pemula.

Tersedia lisensi dalam versi grosir.

Mempunyai ekstensi (.xls) terpopuler untuk software spreadsheet.
Dapat membaca ekstensi standar spreadsheet (.csv).

Fitur pivot untuk mempermudah manajemen data.

Spreadsheet yang besar, dapat digunakan sebagai alternatif SQL
untuk penggunaan sederhana.

Resource RAM dan memory kecil dibanding program sejenis.
Digunakan oleh berbagai industri, instansi dan pekerjaan.
Mendukung Visual Basic

Menyediakan fitur Research Pane untuk mempermudah mencari
referensi analisis data dengan Microsoft Excel menurut para ahli
terkait topik yang diteliti.

6.1.2 Kekurangan Microsoft Excel

1.
2.

Akses fungsi tertentu seperti fungsi statistik terbatas.
Jumlah sel terbatas.
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3. Add-ins untuk disiplin ilmu tertentu seperti neural network, fuzzy
logic tidak powerfull dibandingkan software sejenis contoh:
MATLAB dan SAS .

6.2 Fungsi Microsoft Excel

Microsoft Excel digunakan di berbagai bidang pekerjaan, baik usaha kecil
maupun perusahaan berskala internasional. Adapun beberapa fungsi dan
kegunaan Microsoft Excel adalah sebagai berikut

1. Membuat, mengedit, mengurutkan, menganalisis, meringkas, dan
memformat data serta grafik.

2. Membuat catatan keuangan dan anggaran keuangan.

3. Menghitung dan mengelola investasi, pinjaman, penjualan,
inventaris, dll.

4. Melakukan analisis dan riset harga.

5. Melakukan perhitungan statistika.

6. Membantu berbagai sektor bisnis untuk mempermudah melakukan
laporan keuangan.

7. Membuat daftar nilai sekolah maupun universitas.

o)

Konversi mata uang.

9. Membuat grafik persamaan matematika.

10. Membuat program Excel dengan Visual Basic.

11. Melakukan penelitian dengan berbagai metode penelitian.
12. Sarana pembelajaran komputer dan logika.

13. Dan lain-lain.
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6.3 Workbook

Workbook adalah buku kerja tempat melakukan manajemen data yang dapat
menyimpan lebih dari satu Worksheet pada Microsoft Excel. Istilah Worksheet
adalah lembar kerja elektronik dimana tempat data-data tersimpan. Worksheet
terdiri dari sel yang diidentifikasi dalam baris dan kolom pada Microsoft
Excel. Fungsi Workbook berkaitan dengan seluruh perintah yang ada pada
Microsoft Excel. Tampilan awal Workbook hanya terdiri dari satu Worksheet,
pengguna dapat menambahnya dengan mudah apabila diperlukan. Setiap sel
dapat memuat data baik berupa string (tulisan), angka, atau formula Excel.

6.4 Pengertian Worksheet dan
Fungsinya

Pengertian Worksheet Excel adalah lembar kerja spreadsheet yang berfungsi
sebagai tempat input data oleh pengguna melalui sel, diproses dan ditampilkan
pada workbook. Data tersebut diatur oleh workbook sehingga dapat
dipindahkan atau copy pada worksheet lainnya. Worksheet terdiri atas baris
(row) dan kolom (column). Berdasarkan jumlah baris dan kolom pada
microsoft excel, worksheet Microsoft Excel berisi 17.179.869.184 sel.

XFD1048576 ~ fe v
XEV | XEW XEX XEY XEZ XFA XFB XFC XFD [~

1048568

1048569

1048570

1048571

1048572

1048573

1048574

1048575

1048576 1=

Sheet1 | Sheet2 ©) 4 >
Ready 3 H |- 1 +  100%
Gambar 6.2: Worksheet

1. Baris (row) Excel
Baris pada Microsoft Excel mengidentifikasi sel secara horizontal.
Baris Microsoft Excel diidentifikasi mulai dari baris 1-1.048.576,
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sehingga jumlah baris pada Microsoft Excel adalah 1048576 baris.
Anda dapat menuju sel baris terakhir dengan Ctrl+Page Down.

2. Kolom (column) Excel
Kolom pada Microsoft Excel mengidentifikasi sel secara vertikal.
Kolom Microsoft Excel diidentifikasi mulai huruf A-XFD, sehingga
jumlah kolom Microsoft Excel adalah 16.384. Anda dapat menuju sel
kolom terakhir dengan Ctrl+End.

6.5 Pengertian Sel pada Microsoft Excel

Sel di Excel adalah irisan atau intersection dari suatu baris yang
direpresentasikan dalam angka dan kolom dalam huruf yang kemudian
diidentifikasi dengan nama sel atau alamat sel. Misalkan irisan dari baris 3
dengan kolom B akan membentuk sel dengan alamat sel B3. Alamat sel pada
Excel dapat dilihat pada "Name Box" pada Workbook Microsoft Excel.
Sedangkan pengertian "range' pada Excel adalah sekelompok sel yang
diidentifikasi dengan alamat sel dari sel awal ke sel akhir. Range terkait
hubungannya dengan alamat sel yang terdiri relatif, semi absolut, dan sel
absolut.

= EFE < =

File Home Insert Page Layout Formulas

==y 36 Calibri ~ 111 - ==K = c

UEI%' B I U - A A @ ===B-
Paste = ~ _—

- ~ B - | D~ A~ == - <
Clipboard = Font = Alignment =

I B3 e | P

A I B C | D | E

Alamat Sel

Sel Aktif

UihWwnN -

Gambar 6.3: Sel Pada Excel
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6.6 Pengertian range dalam excel

Jika Cell adalah pertemuan antara Row dan Column atau pertemuan Baris dan
Kolom, maka RANGE atau dalam istilah Indonesia diartikan sebagai rentang
adalah kumpulan dari beberapa cell pada microsoft excel. Jadi pengertian
Range adalah gabungan dari beberapa cell pada microsoft excel, baik dalam
satu atau beberapa baris dan kolom.

6.7 Formula Pada Excel dan Fungsinya

Pengertian formula pada Microsoft Excel adalah sekumpulan ekspresi dimuat
suatu sel, dimana ekspresi tersebut dapat melakukan perhitungan matematika
terhadap data sel lainnya dengan menggunakan rumus Excel yang secara
fundamental disebut fungsi (function). Pada tutorial berikut dijelaskan fungsi
operasi matematika beserta pengertian formula pada Excel dan fungsinya.

Adapun beberapa contoh aplikasi atau kegunaan Formula Excel

Menghitung daftar belanja atau nota di toko.
Menghitung Pajak.

Menghitung pembukuan suatu perusahaan.
Menghitung model matematika suatu permasalahan .
Menghitung Laba Rugi.

Melakukan mengurutkan skor suatu perlombaan.
Melakukan analisis statistika deskriptif.

NonsE W=

6.7.1 Fundamental membuat Formula Pada Microsoft
Excel

1. Untuk membuat formula Excel dimulai dengan tanda

n_n

sama
dengan.

2. Formula Excel dapat memuat operasi matematika dasar serta rumus-
rumus Excel.

3. Formula pada Excel dapat dilakukan perintah Autofill berdasarkan
Alamat Sel yang termuat dalam formula Excel.
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Berikut merupakan Rumus Operasi Matematika Pada Microsoft Excel

Simbol Fungsi

+ Penjumlahan

- Pengurangan

* Perkalian

/ Pembagian

%o Persen

A Perpangkatan

= Sama dengan

< Kurang dari

<= Kurang dari atau sama dengan
> Lebih dari

>= Lebih dari sama dengan
< Tidak sama dengan

6.7.2 Cara Membuat Formula Pada Microsoft Excel Dan
Menggunakan Autofill

Untuk memasukkan formula Excel anda dapat memasukkan langsung di sel
maupun formula bar Microsoft Excel.

Cara Membuat Formula Excel

1. Kiik Sel yang akan dimuat formula Excel

2. Tekan tanda "=" untuk mendefinisikan suatu ekspresi formula Excel

3. Anda dapat memasukkan alamat sel secara manual atau klik sel yang
akan dilakukan operasi hitung atau rumus excel

4. Teken Enter untuk menghitung

5. Anda dapat melakukan autofill jika sel yang anda hitung berada
dalam suatu range
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6.7.3 Cara Menampilkan Formula Pada Microsoft Excel

Anda dapat menampilkan formula yang dibentuk baik yang diinput manual
maupun dengan fitur Autofill pada Worksheet Excel dengan tombol perintah
Show Formulas pada tab menu Formula Ribbon.

Power Pivot Team Q Tell me what you want to do...

#:o Trace Precedents (%] S%w Formulas m EJ
o L

n::E Trace Dependents Y4 Erfdr Checking ~ i
= Watch  Calculation
on I Remove Arrows ~ (%) Evaluate Formula  Wwindow Options ~
Formula Auditing G
Show Formulas (Ctrl+)

Display the formula in each cell
K L instead of the resulting value. p

Gambar 6.4: Menampilkan Formula

6.8 Rumus dalam Excel

Rumus dalam excel dapat membantu para pengguna dalam
menyelesaikan pekerjaanya. Didalam excel rumus yang sangat
populer terdapat dibawah ini.

L.

SUM.

Syntax: =SUM(number1,[number2],...)

Fungsi SUM digunakan untuk menjumlahkan data-data di cell.
Fungsi SUM bisa digunakan untuk menambahkan data per cell, data
dalam satu range, maupun data dalam beberapa range sekaligus.

IF.

Syntax: =IF(logical test,[value if true],[value_if false])

Fungsi IF digunakan untuk mengembalikan atau menampilkan suatu
nilai jika sebuah kondisi atau pernyataan bernilai BENAR, dan
menampilkan nilai lain jika kondisi atau pernyataan bernilai SALAH.
Fungsi IF juga bisa digunakan untuk banyak kondisi dengan cara
menggabungkan beberapa fungsi IF sekaligus atau yang disebut
dengan IF bersarang (fungsi IF di dalam IF). Fungsi IF bisa
digunakan secara bersama sampai dengan 64 fungsi IF.
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3. LOOKUP.
Syntax: =LOOKUP(lookup_value,array)
Fungsi LOOKUP digunakan untuk mencari sebuah nilai data pada
suatu kolom maupun suatu row. Fungsi LOOKUP ini sebenaranya
sudah jarang digunakan dan sudah beralih ke fungsi VLOOKUP dan
HLOOKUP.

4. VLOOKUP.
Syntax: =VLOOKUP(lookup value, table array, col index num,
[range lookup])
Fungsi VLOOKUP digunakan untuk mencari suatu nilai data pada
sebuah range atau tabel, kemudian setelah nilai tersebut ditemukan,
akan memanggil atau menampilkan nilai di kolom yang lain dari
tabel tersebut berdasarkan urutan kolom (index kolom) yang
diinginkan. Salah satu contoh penggunaannya adalah untuk
menampilkan nomor telpon dari tabel data base nasabah.

5. MATCH.
Syntax: =MATCH(lookup value, lookup_array, [match_type])
Kegunaan dari fungsi MATCH adalah untuk mencari suatu nilai
tertentu pada range, list atau tabel, untuk kemudian mengembalikan
(menghasilkan atau menampilkan) posisi relatif nilai tersebut di
range, list atau tabel tersebut. Output dari fungsi ini adalah berupa
nomor urutan nilai yang dicari. Misalnya ada urutan nama Andi,
Budi, Caca, maka posisi relatif atau urutan Caca ada di nomor 3.

6. CHOOSE.
Syntax: =CHOOSE(index num, valuel, [value2], ...)
Fungsi CHOOSE digunakan untuk memilih dan menampilkan satu
nilai pada sekumpulan atau satu list nilai. Fungsi CHOOSE bisa
digunakan untuk memilih 1 nilai dari sampai dengan 254 nilai
berdasarkan nomor index. Sebagai contoh, jika nilail sampai dengan
nilai7 adalah nama-nama hari dalam seminggu, fungsi CHOOSE
akan menampilkan salah satu hari jika kita menggunakan nomor
index 1-7.
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7.

10.

DATE.

Sytax: =DATE(year,month,date)

Fungsi DATE digunakan untuk menampilkan nomor seri sekuensial
yang merepresentasikan suatu tanggal tertentu. Fungsi ini sangat
berguna jika kita menemukan kondisi dimana tahun, bulan dan
tanggal ada pada cell terpisah.

DAYS.

Syntax: =DAYS(end_date, star _date)

Fungsi DAYS digunakan untuk menghitung jumlah hari di antara dua
tanggal. Fungsi ini antara lain bisa digunakan untuk melakukan
hitung mundur (count down) event tertentu, atau mengetahui masa
kadaluarsa suatu bahan makanan.

FIND.

Syntax: =FIND(find_text, within_text, [start num])

Fungsi FIND ini digunakan untuk menemukan suatu teks atau
potongan teks (string) tertentu pada sebuah cell yang berisi teks yang
panjang. Jika sebuah string ditemukan pada sebuah teks, fungsi ini
akan menampilkan posisi atau urutan karakter pertama string
tersebut. Sebagai contoh, jika kita mencari string "ant" pada kata "aku
ganteng", fungsi FIND akan menghasilkan nilai 6, karena huruf a
pada string "ant" ada pada posisi urutan karakter ke-6. Perlu dicatat
bahwa fungsi FIND bersifat Case Sensitive dimana string "ant" tidak
sama dengan "Ant".

INDEX.

Syntax: =INDEX(array, row_num, [column_num])

Kegunaan fungsi INDEX adalah untuk mengambil atau
menghasilkan sebuah nilai dari range atau tabel. Dengan kata lain,
fungsi ini akan mengambil suatu nilai tertentu di range atau tabel
sesuai yang kita inginkan. Sebagai contoh, jika kita ingin mengambil
nilai “Wortel” dari list kolom sayuran {"Tomat","Wortel","Cabe"},
kita bisa melakukannya dengan fungsi INDEX dengan cara
mengindex lokasi nilai yang kita inginkan. Pada contoh di atas, nilai
“Wortel” terletak atau berada pada kolom ke-2.
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